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Thank you for purchasing the Panasonic KX-P8420 Color Laser Printer.

 

The serial number is located on the label on the rear of the unit. For your convenience, record the 
number below and keep this book along with your proof of purchase, in the event of a theft or for future 
reference.

MODEL NO.      

 

KX-P8420

 

SERIAL NO.

NAME OF RESELLER DATE OF PURCHASE
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the E

 

NERGY

 

 S

 

TAR

 

® guidelines for energy efficiency.
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 is a U.S. registered mark.)

Adobe, Acrobat, PostScript, PostScript 3, Adobe Type Manager and the PostScript 3 
logo are trademarks of Adobe Systems Incorporated.

Fiery, Fiery Driven, the Fiery Driven logo, ColorWise, and VisualCal are trademarks 
owned by Electronics for Imaging and registered with the U.S. Patent and 
Trademark Office and in certain other foreign jurisdictions.

 

•

 

Apple, AppleTalk, LocalTalk, ColorSync, Macintosh, and TrueType are trademarks or registered trademarks 
of Apple Computer, Inc.

 

•

 

Ethernet is a trademark of Xerox Corporation.

 

•

 

IBM is a trademark of International Business Machines Corporation.

 

•

 

Java is a trademark of Sun Microsystems, Inc.

 

•

 

Netscape and Netscape Navigator are trademarks of Netscape Communications Corporation.

 

•

 

NetWare, Novell and Internetwork Packet Exchange (IPX) are trademarks or registered trademarks of 
Novell, Inc.

 

•

 

Times and Helvetica are trademarks of Linotype-Hell AG and/or its subsidiaries.

 

•

 

PANTONE is a trademark of Pantone, Inc.

 

•

 

UNIX is a trademark of X/Open Company, Ltd.

 

•

 

Microsoft, MS-DOS, Windows and Windows NT are registered trademarks of Microsoft Corporation in the 
United States and/or other countries.

 

•

 

Pentium is a registered trademark of Intel Corporation.

 

•

 

Centronics is a trademarks of Centronics Data Computer Corporation.

 

•

 

Avery is a registered trademark and all Avery codes are trademarks of Avery Dennison Corporation.

 

•

 

All other acknowledgements are trademarks or registered trademarks of their respective holders.

It is granted from Microsoft Corporation to use Microsoft® Windows® Screen Shots.
Acrobat® Reader copyright ©1987-1996 Adobe Systems Incorporated. All rights reserved.

The operating instructions are subject to change without notice.

© ELECTRONICS FOR IMAGING, INC. 1998
© KYUSHU MATSUSHITA ELECTRIC CO., LTD. 1998
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FOR USERS IN UNITED STATES

 

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant 
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, 
uses and can radiate radio frequency energy and, if not installed and used in accordance with the 
instructions manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful interference in which case the 
user will be required to correct the interference at his own expense.

 

FCC Caution:

 

  To assure continued compliance, (example—use only shielded interface cables when 
connecting to computer or peripheral devices). Any changes or modifications not expressly approved by 
the party responsible for compliance could void the user’s authority to operate this equipment.

 

Technical Support Calls 

 

If you have read this manual and tried the troubleshooting procedures and you are still having difficulty, 
please contact the reseller from which the unit was purchased. You may also call the end user technical 
support telephone number which is operational during East Coast business hours (9:00 AM to 7:00 PM). 
The end user technical support number is 1-888-744-2424. 
This number is available within the U.S. only.

 

Helpful Phone Numbers

 

To locate your nearest sales dealer CALL 1-800-742-8086 ask for COLOR 
To order consumables CALL 1-800-222-0584 
To order operating instructions/CD’s CALL 1-800-833-9626 
To locate your nearest authorized service center CALL 1-888-744-2424 
For technical support CALL 1-888-744-2424 
Automated 24-hour support via Fax back CALL 1-800-222-0584 
Electronic bulletin board CALL 1-201-863-7845 
World Wide Web Technical & Driver Support http://www.panasonic.com/alive
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For Your Safety

 

General

 

Warning

 

•

 

To prevent fire or shock hazard, do not expose this product to rain or any 
type of moisture.

 

Caution

 

•

 

Do not open covers and do not attempt to repair the unit yourself. Refer 
servicing to qualified personnel.

 

Power source

 

Warning

 

•

 

The power source voltage of this unit is listed on the nameplate. Only plug 
the unit into an outlet with the proper voltage.

 

•

 

When you operate this equipment, the outlet should be near the 
equipment and accessible.

 

•

 

To ensure safe operation the AC cord supplied must be inserted into 
standard three-prong AC outlet which is effectively grounded (earthed) 
through the normal wiring.

 

•

 

The fact that the equipment operates satisfactorily does not imply that the 
power point is grounded (earthed) and that the installation is completely 
safe. For your safety, if in any doubt about the effective grounding 
(earthing) of the power point, consult a qualified electrician.

 

•

 

If the plug cannot be inserted into the AC outlet, contact a licensed 
electrician to replace the outlet with a properly grounded (earthed) one. 
Do not defeat the purpose of the grounding (earthing) plug (ex. do not use 
a conversion plug).

 

Laser safety

 

Caution

 

•

 

This printer utilizes a laser. Use of controls or adjustments or 
performance of procedures other than those specified herein may result 
in hazardous radiation exposure.

 

Ozone release

 

Warning

 

•

 

Make sure that the printer is installed in a well ventilated room so as not to 
increase density of ozone in the air. Since ozone is heavier than air, it is 
recommended that air at floor level be ventilated.
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For Your Safety

 

Moving the unit

 

The printer weighs approximately 47.9 k

 

g

 

 {105.5 lbs.}. It must be handled by 
two people. Turn the power off and remove the power cord when handling 
the unit.
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For Your Safety

 

Caution labels 

 

FOR USERS IN AUSTRALIA

 

 This mark shows that the product complies with AS/NZS 3548.

ATTENTION:
SURFACE
CHAUDE
CI-INTERIEUR

VORSICHT:
HEISSE FLÄCHE
INTERN

ATENCION:
SUPERFICIE
CALIENTE
EN EL INTERNO

CAUTION:
HOT SURFACE
INSIDE

CAUTION:

HOT SURFACE INSIDE

CAUTION:HOT SURFACE BELOW
ATTENTION:SURFACE CHAUDE CI-DESSOUS
VORSICHT:HEIßE OBERFLÄCHE DARUNTER
ATENCION:SUPERFICIE CALIENTE ABAJO

CLASS
KLASSE
CLASSE
CLASE

1 LASER PRODUCT
1 LASER PRODUKT
1 LASER PRODUIT
1 LÁSER PRODUCTO

ATTENTION:
Rayonnement laser invisible
dangereux en cas
d'ouverture et lorsque
la sécurité est neutralisée.
EXPOSITION DANGEREUSE
AU FAISCEAU.

VARNING:
Osynlig laser-
strålning när denna
del är öppnad och
spärrar är
urkopplade.
STRÅLEN
ÄR FARLIG.

VARO!:
Näkymätöntä
avattaessa ja
suojalukitus
ohitettaessa olet
alttiina lasersäteilylle.
ÄLÄ KATSO
SÄTEESEEN.

VARNING:
Osynlig laserstrålning
när denna del är
öppnad och spärren är
urkopplad.
BETRAKTA EJ
STRÅLEN. 

ADVARSEL:
Usynlig laserstråling
ved åbning når
sikkerhedsafbrydere
er ude af funktion.
UNDGÅ 
UDSÆTTELSE FOR
STRÅLING.

PELIGRO:
Cuando se abre y se
invalida el bloqueo, se
producen radiaciones
invisibles de láser.
EVÍTESE LA
EXPOSICIÓN
A TALES RAYOS.

DANGER:
Invisible laser radiation
when open and interlock
defeated.
AVOID DIRECT
EXPOSURE TO BEAM.

CAUTION:
Invisible laser radiation
when open and 
interlocks defeated.
AVOID EXPOSURE
TO BEAM.

VORSICHT:
Unsichtbare Laserstrahlung,
wenn Abdeckung geöffnet
und Sicherheitsverriegelung
überbrückt.
NICHT DEM STRAHL
AUSSETZEN.

ADVARSEL:
Usynlig laserstråling
når deksel åpnes og
sikkerhedslas brytes.
UNNGÅ
EKSPONERING
FOR STRÅLEN.

(220–240 VAC equipment)

Laser diode properties
Laser output : 5 mW max
Wavelength : 780 nm
Emission duration : Continuous

N52
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For Your Safety

 

FOR USERS IN U.K.

 

IMPORTANT:

FOR YOUR SAFETY PLEASE READ THE FOLLOWING TEXT CAREFULLY

 

This printer is supplied with a moulded three pin mains plug each for your safety and convenience. 
A 13 amp fuse is fitted in this plug. Should the fuse need to be replaced please ensure that the 
replacement fuse has a rating of 13 amps and that it is approved by ASTA or BSI to BS 1362.

Check for the ASTA mark  or the BSI mark  on the body of the fuse.

If the plug contains a removable fuse cover you must ensure that it is refitted when the fuse is replaced. 
If you lose the fuse cover the plug must not be used until a replacement cover is obtained. A 
replacement fuse cover can be purchased from your local Panasonic Dealer.

 

IF THE FITTED MOULDED PLUG IS UNSUITABLE FOR THE SOCKET OUTLET IN YOUR HOME 
THEN THE FUSE SHOULD BE REMOVED AND THE PLUG CUT OFF AND DISPOSED OF SAFELY. 
THERE IS A DANGER OF SEVERE ELECTRICAL SHOCK IF THE CUT OFF PLUG IS INSERTED 
INTO ANY 13 AMP SOCKET.

 

If a new plug is to be fitted please observe the wiring code as shown below. 
If in any doubt please consult a qualified electrician.

 

WARNING:

 

 THIS APPLIANCE MUST BE EARTHED.

 

IMPORTANT:

 

 The wires in this mains lead are coloured in accordance with the following code.

Green-and-Yellow: Earth Blue: Neutral Brown: Live

As the colours of the wire in the mains lead of this appliance may not correspond with the coloured 
markings identifying the terminals in your plug, proceed as follows.

The wire which is coloured GREEN-AND-YELLOW must be connected to the terminal in the plug which 
is marked with the letter E or by the Earth symbol  , or coloured GREEN or GREEN-AND-
YELLOW.

The wire which is coloured BLUE must be connected to the terminal in the plug which is marked with the 
letter N or coloured BLACK.

The wire which is coloured BROWN must be connected to the terminal in the plug which is marked with 
the letter L or coloured RED.

 

How to replace the fuse:

 

 Open the fuse compartment with a screwdriver and replace the fuse.

 

.

ASA

L N

SCREWDRIVER

FUSE

FUSE COVER
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Before You Start

 

Before you set up your new printer, please read the following information.

 

Cautions

 

To avoid problems, do not use the equipment under the following conditions:

 

•

 

Direct exposure to sunlight

 

•

 

Extremely high or low temperature [temperature range: 10˚C to 32.5˚C 
(50˚F to 90.5˚F)]

 

•

 

Extremely high or low humidity (humidity range: 20% to 80% RH)

 

•

 

Condensation due to rapid change of temperature

 

•

 

Areas of poor ventilation

 

•

 

Areas of high dust or chemical fume concentration (solvent etc.)

 

•

 

Unstable or unlevel surfaces
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•

 

Directly in front of air conditioning vents

 

•

 

Liquids near the equipment

 

•

 

Too much media/document which exceeds the limit mark on the guide of 
the tray.

 

•

 

Front/right/left doors opened while the printer is operating; it may cause a 
media jam.

 

•

 

Any toner other than genuine Panasonic toner. It may damage the printer.

Not genuine toner
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•

 

To prevent accidental damage to the CD-ROMs:

 

• Do not touch or write on the surface of the disc.

• Do not leave the disc out of the protective case.

• Do not leave the disc in direct sunlight or near heat sources.

• Do not place heavy objects on the disc case or drop the case.

• To clean the disc, hold the disc by its edges and wipe it from the center to 
the edges with a dry, soft cloth.

CD-ROM
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To prevent static electricity damage to any of the following components, 
touch a grounded metal surface, such as the printer’s bare metal frame prior 
to touching the component.

• The interface connectors—parallel and optional network

• Electrical components, connectors inside the printer, any components on 
the optional board (hard disk drive, RAM DIMMs, Ethernet network card, 
or Token Ring network card)

• The connector pins on the optional 2nd cassette feeder for the printer

Waste material may be dumped or incinerated under conditions which meet 
all federal, state and local environmental regulations.

Static electricity 
damage

Waste disposal 
method
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Features of the KX-P8420
The KX-P8420 Color Printer provides fast, high-quality color printing on 
plain paper, plus the ease of operation and high performance you expect 
from a laser printer, including the following.

• Resolution—maximum 1200 x 1200 dpi (with optional additional memory)

• Continuous printing on Letter or A4 size paper 
Full-color mode—Maximum 3.5 ppm (pages per minute) 
Three color mode—Maximum 4.7 ppm 
Monochrome mode—Maximum 14 ppm

• Printer driver—easily prints full-color documents

• Supports AppleTalk (EtherTalk), TCP/IP, and IPX (Novell) protocols 
simultaneously by installing optional Ethernet Card

• Supports thicknet, twisted pair, and thinnet (via transceiver) cabling

• Ethernet or Token Ring support by installing optional Ethernet or Token 
Ring Card

• SMB (Microsoft®)

• IEEE 1284 compliant, Mini-Centronics type-C parallel connection based 
on the IEEE P1284-C standard

NOTE:
• An ECP compatible parallel port is recommended for Windows® 95*1. To 

turn on the ECP mode, use the computer’s BIOS setup. Refer to the 
computer’s documentation for details.

*1 Microsoft® Windows® 95 operating system (hereafter Windows 95)

High quality

High speed

Easy operation

Networking and 
client capabilities
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ColorWise™ CRDs (color rendering dictionaries) take full advantage of the 
colors available on your printer. PostScript 3 RGB files are converted to the 
printer’s CMYK color space during processing—optimizing them for 
rendering and printing. CRDs available with the PostScript driver include: 

• Photographic

• Presentation

• Transparency

Using the PostScript driver an image’s RGB data can be also converted to 
the color space and gamut of the KX-P8420 printer using RGB source 
profiles. Profiles available include:

• EFIRGB

• sRGB (PC)

• Apple Standard

In addition, CMYK simulation settings can be used to simulate popular 
offset printing press standards. Simulation settings include:

• SWOP

• Euroscale

• DIC

ColorWise VisualCal™ allows experienced users to calibrate the KX-P8420 
for excellent color output—eliminating out-of-calibration color most printers 
experience over time.

ColorWise Color Adjustment provides controls for globally modifying toner 
density and brightness. 

ColorWise Business Color specifies the application of toner using a 
diffusion dither pattern, which is ideal for color fills and blends commonly 
found in charts and graphs used in business applications. 

Color capabilities

Color management
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Fiery WebTools are utilities that enable users to manage the KX-P8420 
from the Internet or your company’s intranet:

• Fiery WebDownloader 

• Status

• Fiery WebSetup

• Fiery WebLink

• Fiery WebSpooler 

For additional information on KX-P8420 specifications, see “Specifications” 
on page 195.

The icons in this document indicate:

: You need to install hard disk drive (option). 
See “Installing a hard disk drive” on page 186.

: You need to install an additional memory (total 32 MB). 
See “Installing additional memory” on page 189.

: You need to use the printer in a networked environment. 
See “Chapter 3 Connecting the Printer to a Network”.

Fiery WebTools

32
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System requirements
You can use the printer in a networked environment and print from a PC 
compatible computer running Windows or from a Macintosh computer.

The minimum hardware configuration required to use the printer with an 
IBM PC or compatible includes:

• An IBM PC or compatible computer with a 386 processor or higher

• A mouse that is supported by Windows

• Windows 3.1*1 or later, Windows 95 or Windows NT® 4.0*2*3 (Intel 
version) or later 

• Appropriate interface cables for your network or printer connection

• Screen resolution more than or equal to 800 x 600 dpi to use Fiery 
WebTools

• Screen color more than 256 color to use Fiery WebTools

The minimum hardware configuration required to use the printer with a 
Macintosh computer is:

• Any Macintosh computer in the Macintosh II, Quadra, Centris, Performa, 
or Power Macintosh families with EtherTalk Phase 2 installed

• Apple system software version 7.5.x or 7.6.x

• Appropriate interface cables for your network and printer connection.

• Ethernet Card (page 192)
It does not enable to connect KX-P8420 to Macintosh computer directly. 
The data is printed through the Ethernet Card installed in the KX-P8420.

*1 Microsoft® Windows® operating system Version 3.1 (hereafter Windows 
3.1)

*2 Microsoft® Windows NT® Workstation operating system, and Microsoft® 
Windows NT® Server network operating system Version 4.0 (hereafter 
Windows NT 4.0)

*3 Service Pack 3 or later version is required.

With a Windows 
computer

With a Macintosh 
computer
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Minimum space requirements 

Power source
• The voltage level of the power source must not vary more than ±10% from 

the voltage level marked on the nameplate (located on the back of the 
unit).

• Do not use an extension cord.

• Do not use a line conditioner, transient suppressor or surge protector as it 
may cause a machine error.

Rear

RightLeft

45 cm (17.7")
Multi-purpose tray
opening space

35 cm (13.8")
Controller board
opening space

50 cm (19.7")
Media tray
opening space

60 cm (23.6")
Front cover
opening space
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Unpacking
Make sure that all of the items shown below were provided and have not 
been damaged. Report damage or shortages to the reseller from which the 
unit was purchased. Page 2 includes an area for recording important 
information such as the name of reseller, serial number, and date of 
purchase.

NOTE:
• Save the original carton and packing materials for future shipping and 

transporting of the unit. They have been specifically designed to protect 
the equipment during shipment.

1. Printer (Color imaging unit, Fuser unit, Paper tray and Output tray are 
included.)

2. Toner cartridges (black, cyan, magenta, and yellow)

3. Power cord

4. KX-P8420 Driver & Utility CD-ROM

5. KX-P8420 Operating Manuals CD-ROM (includes Drivers and Utilities 
Reference Guide and Operating Instuctions)

6. Color Calibration Card

7. Setup Manual

1 2 3

4 6 75
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Part names
Front side view

Printer panel (See page 24.)

Right side door 
(See pages 29 and 154.)

Output tray 
(See page 27.)

Fuser (See pages 141 and 149.)

Imaging unit (See pages 26 and 140.)Front door (See page 26.)

Rear side view

Multi-purpose tray (MPT) 
(See page 40.)

Left side door 
(See page 36.)
[Media thickness switch* 
(See page 36.)]
*Accessible by opening the 
left side door

Parallel interface
connector 
(See page 33.)

AC inlet
(See page 33.)

Power switch
(See page 34.)
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Front panel overview
This section describes the functions of the front panel, illustrated below:

The printer LCD has two 24-character lines to display the printer’s status/
error messages or menu settings.

The activity lights indicate the status of the printer. They have the following 
meanings:

This light Indicates

Ready indicator—Lit when the printer is on line (ready 
to accept and process new jobs), blinking when in menu 
mode and when receiving, processing or printing data, 
and off when the printer is offline or the power is off. 

NOTE:
• When the printer is off line, you cannot print or connect 

via a network.

Error indicator—Blinking when the printer requires 
operator intervention (e.g., load paper); or when the 
printer requires a service call.

LCD (Liquid 
Crystal Display) 
panel

MENU
/EXIT

CONTINUECANCEL

ENTER

READY

ERORR

Activity lights

READY

ERORR
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The front panel’s buttons have the following meanings:

This button Indicates

Menu/Exit button—From Ready (or Sleep), enters 
Menu mode. From Menu mode, exits menus entirely, 
returning to Ready.

Cancel/Left button—While printing, Cancel stops 
printing or processing the current job. In Menu mode, 
returns to the previous menu item. When entering 
numbers, decrements to the next number.

Continue/Forward button—Advances to the next 
selection in menu mode. When entering numbers, 
increments to the next number. When using the Semi 
Automatic Duplexing function in the printer driver, after 
odd pages are printed, even pages are printed by 
pressing this key.

Enter button—Accepts an option and advances to the 
next choice in menu mode.

Buttons

MENU
/EXIT

CANCEL

CONTINUE

ENTER
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Printer Setup

This chapter describes setting up the KX-P8420 Color Printer, connecting it 
to a PC compatible computer, and powering on the printer. It also includes 
print area specifications, guidelines for using the multi-purpose tray (MPT), 
and instructions on using the front panel.

Setting up the printer
The general steps for setting up the printer are:

• “Preparing the imaging unit” on page 26

• “Setting up the output tray” on page 27

• “Installing the toner cartridges” on page 28

• “Loading media” on page 30

After you have unpacked the printer and located it on a flat, stable surface, 
you need to set it up.

To prepare the imaging unit:

1 Open the front door.

Preparing the 
imaging unit
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2 Turn the upper green lever clockwise until it stops and 
the arrows are aligned.

This tightens the internal belts to ready the unit for printing.

3 Close the front door.

Make sure that you have enough room for the output tray and that it is easy 
to access.

To set up the output tray:

1 Remove the adhesive tape that holds the output tray 
against the printer.

Setting up the 
output tray
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2 Lower the tray to the operating position.

The toner cartridges that are shipped with the printer are starter cartridges. 
They are installed in exactly the same manner as the optional cartridges; 
the only difference is that the starter cartridges have less toner. The page 
life expectancy is 3,000 pages, based on a 5% image area.

NOTE:
• Save all packing material for shipping purposes.

To install the starter cartridges:

1 Remove the packaging from the toner cartridge.

2 Remove the shipping cover from the cartridge.

CAUTION:
• To avoid possible toner spillage, do not tilt cartridge.

Installing the 
toner cartridges
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3 Open the right side door.

CAUTION:
• Do not leave the right side door open for more than 1 minute; the 

imaging unit will be exposed to light and could be damaged.

4 Insert the toner cartridge in the appropriately labeled 
slot. 

From top to bottom, the order of the color toner cartridges is black, 
cyan, magenta, and yellow.

5 Repeat steps 1, 2, and 4 for each toner cartridge. 
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6 When you have installed all the toner cartridges, go to 
step 7.

7 Close the right side door.

The printer is shipped with one media tray (either Letter Paper or A4 Paper) 
installed—but it enables to use five different trays as shown in the following 
table.

NOTES:
• Make sure that you load the correct media. Each tray is designed and 

labeled for only paper or transparency. If you load the incorrect media 
type in a tray, it may cause a jam.

• If you have the 2nd cassette feeder installed and you wish to use the 
automatic cassette-switching feature (for a large print job, for example), 
make sure that all trays in the printer are the same media type and size.

• The transparency tray should only be inserted in the upper or middle tray 
slots.

Tray Size

A4 Paper 210 mm x 297 mm (8.3" x 11.7")

A4 Transparency 210 mm x 297 mm (8.3" x 11.7")

Letter Paper 216 mm x 279 mm (8.5" x 11")

Letter Transparency 216 mm x 279 mm (8.5" x 11")

Legal Paper 216 mm x 356 mm (8.5" x 14")

Loading media 
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To load paper or transparencies:

1 Pull the media tray out of the printer.

2 Remove all packaging materials from inside the media 
tray; refer to the instruction sheet attached to the tray.

3 Push down on the metal plate until it clicks, locking it in 
place.

4 Fan the media (paper or transparencies), and then tap it 
on a level surface to avoid media jams or skewed 
printing.
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NOTES:
• To optimize your printer’s performance, always use clean, 

unused media.

• Be careful not to leave fingerprints on the media, which can result 
in a smudged print.

• Reusing media that has been fed through the printer once (for 
example, after jams) can reduce the life of the consumables and 
paper path components.

• The recommended transparency is 3M CG3700. If the print 
quality is poor, try printing on the other side.

5 Place the media in the tray under the hooks. 

The height of media should not exceed the limit mark on the tray, or 
it may cause a jam.

NOTES:
• Load media with the print side down. Most media has instructions 

recommending the side to be printed first.

• Do not mix different types or thicknesses of media in the media 
tray at one time; this may cause a jam.

6 Slide the media tray completely into the slot.

Only one PC compatible computer can be directly connected to your printer.Connecting the 
printer to a 
computer
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If you do not have a parallel interface cable, you will need to purchase one 
from your local computer store or dealer (see cross-ref to parallel interface 
cable spec).

To connect a parallel interface cable:

1 Make sure the computer, printer and the other 
connected peripheral devices are turned off.

2 Connect the parallel interface cable to the computer’s 
parallel interface connector and the printer’s parallel 
interface connector.

NOTES:
• The actual connector on the computer may differ depending on 

the manufacturer of the computer.

• If the cable is connected to the PC via a printer buffer or selector, 
the printer may not print.

3 Connect the power cord to the printer’s AC inlet and to 
an AC outlet.

Using a parallel 
interface cable

Computer’s parallel 
interface connector
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To power on the printer:

Turn ON the printer, and then the computer.

The Ready indicator on the printer starts flashing and Initializing is 
displayed on the printer’s front panel. After approximately 
5 minutes, the printer’s Ready indicator is lit and Ready is displayed on the 
printer’s front panel. The printer is ready for printing.

NOTE:
• When you power on your system for the first time, if New Hardware Found 

is displayed on the computer screen, close the dialog box, and install the 
printing software using the procedure described in “Installing the 
PostScript printer driver for Windows 95” on page 75.

Power on
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When the image is printed on the media, the image (print area) is a bit 
smaller than the media size. You may need to adjust the page margins in the 
application software to match the print area.

The following table and illustrations show the page sizes, the largest print 
areas, and the margins for the media sizes supported on this printer.

Media Page Size Print area
Margins

Top Bottom Sides

Letter 216 mm x 279 mm 
(8.5" x 11")

208 mm x 269 mm 
(8.2" x 10.6")

4.3 mm 
(0.17")

4.3 mm 
(0.17")

3.7 mm 
(0.15")

A4 210 mm x 297 mm 
(8.3" x 11.7")

203 mm x 289 mm 
(8.0" x 11.4")

3.6 mm 
(0.14")

3.6 mm 
(0.14")

4.1 mm 
(0.16")

Legal 216 mm x 356 mm 
(8.5" x 14")

208 mm x 350 mm 
(8.2" x 13.8")

3.1 mm 
(0.12")

3.1 mm 
(0.12")

3.7 mm 
(0.15")

Margins and print 
area 

Letter
216 mm x 279 mm

(8.5" x 11")

A4
210 mm x 297 mm

(8.3" x 11.7")

Legal
216 mm x 356 mm

(8.5" x 14")

208 mm 
(8.2")

208 mm 
(8.2")

203 mm 
(8.0")

26
9 

m
m

 (
10

.6
")

28
9 

m
m

 (
11

.4
")

35
0 

m
m

 (
13

.8
")
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The multi-purpose tray (MPT) serves as an additional tray for loading any 
type of media that ranges in size from 91 mm x 254 mm to 216 mm x 356 
mm (3.6" x 10" to 8.5" x 14"). Use it to load a single sheet or a stack of 
media, depending on the media’s type and thickness.

Use the multi-purpose tray to accomplish the following:

Print on standard and special media

• Standard media

— Laser paper [75 to 165 g/m2 (20 to 44 lbs.)]

• Special media

— Labels

— Envelope (#10 size) [Black Text only]

— Transparency (The print quality may not be stable. Use the media tray 
for best reliability.)

Two-sided printing (doubles-sided) on laser paper

You should not expect the same print quality and reliability that you get with 
one-sided printing. For details, see “Two-sided printing” on page 198.

Setting media thickness switch:

Because the printer accommodates various media weights from the multi-
purpose tray, media thickness can be manually selected for the most 
reliable paper-picking. Follow these steps:

1 Open the left side door (a). The green media thickness 
switch is located on the paper feeder and has three 
settings:

Loading media in 
the multi-purpose 
tray

a

Thick
Middle

Thin
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2 Move the switch to the desired setting.

3 Close the left side door.

Loading Paper, Transparency, Coated Paper:

NOTES:
• Reusing media that has been fed through the printer (for example, after 

jams) can reduce the life of the consumables and paper path 
components.

• When printing legal size using the multi-purpose tray, backside marking 
may occur. If this occurs, use the legal cassette.

For detailed information on media, see “Media” on page 196.

1 Set the media thickness switch (page 36).

2 Open the multi-purpose tray (a).
Extend the media support by sliding it outward (b).

Switch setting Media

Thin (Default) Laser paper 75 to 90 g/m2 (20 to 24 lbs.)

Middle Laser paper 91 to 123 g/m2 (25 to 32 lbs.)
Transparency, Label, Coated paper

Thick Laser paper 124 to 165 g/m2 (33 to 44 lbs.)
Envelope

a

b
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3 Separate the media guides to the approximate width of 
the media.

4 Fan the media, and then tap it on a level surface to avoid 
media jams or skewed printing.

5 Insert the media with the printing side up into the multi-
purpose tray. 

The height of media should not exceed the limit mark on the left 
guide, or it may cause a media jam.

6 Adjust the media guides to the media size.

7 Use the printer driver to select the multi-purpose tray.
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To load an envelope in the multi-purpose tray:

Do not insert more than one envelope at a time. Only black text can be 
printed on envelopes. For more detailed information, see “Envelopes” on 
page 200.

1 Set the media thickness switch (page 36).

2 Adjust the media guides to the width of the envelope.

3 Insert the envelope with the short end entering the 
printer first and the printing side facing up. 

The edge where the stamp will be located enters the printer last.

4 From your computer, use the printer driver to choose 
Envelope from the Paper Size menu and Paper Source 
menu.
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To load labels in the multi-purpose tray:

For detailed information on labels, see “Transparencies and labels” on 
page 199.

1 Set the media thickness switch (page 36).

2 Adjust the media guides to the width of the label sheets.

3 Insert the label sheets in the multi-purpose tray with the 
printing side up and the top of the sheets enter first. 

The height of labels should not exceed the limit mark on the guide.

4 From your computer, use the printer driver to choose 
Label.

NOTE:
• Printing labels in high temperature condition may damage the 

consumables and should be avoided.
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Using the front panel
The printer’s front panel enables you to set options and view the status of 
the printer and print jobs. This section provides information about:

• Status messages and error messages

• Top-level menus you can access from the front panel

• Printing printer information pages from the front panel

This section describes the functions of the front panel, illustrated below:

The 2 line, 24 character LCD window on the front panel displays status 
messages. When the printer is printing normally, status information about 
the current jobs appear in the display window. 

For a detailed explanation of the activity lights and buttons on the front 
panel, see “Front panel overview” on page 24.

When the printer is printing normally, status information about current jobs 
appears in the display window. The messages are:

• Ready—Displays while the printer is ready to print but not processing or 
printing a job. 

• Printing—Displays while a job is printing.

• Processing—Displays while the job is processing.

• Canceling Job—Appears when you cancel a print job.

• Ready(Sleep)—Appears when the printer is in an energy-saving mode. 
This mode can reduce the total power consumption of the printer to less 
than 35 watts. Full power mode is restored when the printer receives a job 
or when you press the Menu button and print a page at the printer

Before the printer can print after being in Ready(Sleep), it needs to warm up 
to heat up the fuser. The actual warm-up time depends on how long the 
printer has been in power saver mode. If the printer has been in 
Ready(Sleep) power saver mode for a long time, the warm-up period will be 
longer. 

MENU
/EXIT

CONTINUECANCEL

ENTER

READY

ERORR

Status messages 
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If there is a printing problem, the Error indicator will be on, and an error will 
appear in the display window. For information about error messages, see 
“Front panel status and error messages” on page 167.

The table below describes the printer’s top-level menus. To access the 
menus, press the Menu/Exit button. To scroll through the menus, press the 
Continue/Forward or Cancel/Left button on the front panel. 

Some of these menus (Parallel Port Setup, Network Port Setup, and 
Network Protocol Setup) are used to configure the printer’s initial Setup, 
which must be completed before users can send jobs to the printer. For 
information on performing the initial Setup from the front panel, see 
page 102. 

Choose To specify See also

Test Page Printing one of three sample pages, 
stored in the printer’s ROM: Font 
List, Test Print, and Configuration 
page.

Page 44

Check And 
Print

Printing additional copies of a 
Check and Print job after the initial 
Check and Print copy has been 
printed. Specify the number of 
additional copies of the job to print 
using the Check and Print screens 
from the printer’s front panel. 

NOTE:
• Check and Print is available only 

on printers with a hard disk drive.

For Macintosh, see 
Chapter 2 of 
Drivers and 
Utilities Reference 
Guide.

For Windows, see 
Chapter 1 of 
Drivers and 
Utilities Reference 
Guide.

Bias 
Adjustment

Toner density. See “Chapter 7 
Color Calibration”.

Visual 
Calibration

Color calibration of the printer. See “Chapter 7 
Color Calibration”.

Color 
Adjustment

Toner density and brightness. See “Chapter 7 
Color Calibration”.

Maintenance Display the remaining percentage of 
each consumables.

Page 143

Image Area The amount of the last printed page 
covered by toner, for all toner 
colors. 

The average amount of the printed 
page covered by toner, for all toner 
colors since a toner cartridge 
replacement. 

Page 143

Error messages

Top-level menus
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NOTE:
• Network Port Setup and Network Protocol Setup appear only for 

networked printers.

ENERGY 
STAR

Enable entering ENERGY STAR 
mode which can reduce the total 
power consumption of the printer to 
less than 35 watts.

Page 103

Parallel Port 
Setup

Enable printing through the parallel 
port, set parallel port timeout, 
specify data mode.

Page 103

Network Port 
Setup

Specify Ethernet or Token Ring 
settings for network connections to 
the printer.

Page 103

Network 
Protocol 
Setup

Specify settings for network 
protocols, including TCP/IP, 
AppleTalk, and IXP/SPX.

Page 105

Language Specify the language of the LCD 
text, and the language used in the 
Test, Configuration, and Calibration 
pages.

Page 107

Reset 
Queues

Clear all jobs from queues and clear 
the Job Log.

Page 107

Hard Disk Initialize hard disk drive. This 
message does not appear if a hard 
disk drive is not installed.

Page 107

Choose To specify See also
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There are several pages that you can print from the front panel. This section 
provides instructions for printing a Test page, a Configuration page, and 
PostScript Font List pages. 

The Test page includes a color sample as well as the printer’s name, 
enabled network protocols, memory configurations, and installed options.

The Configuration page lists information about the printer, the current Setup 
configuration, and the number of printer fonts. It’s a good idea to print a 
Configuration page before you make Setup changes, in case you need to 
restore some settings later.

The PostScript Font List pages print out the list of available printer fonts.

You can print a Test page before you set up the KX-P8420—or at any other 
time from the Ready or the Ready(Sleep) screen.

To print a Test page:

1 Turn on the printer and allow it to warm up.

Messages appear on the front panel as the KX-P8420 printer runs 
through its power-up tests.

2 From the Ready screen, press the Menu/Exit button on 
the printer’s front panel.

3 Press the Enter button. 

4 Press the Continue/Forward button until you see Test 
Print and then press the Enter button.

5 Examine the quality of the Test page.

Printing pages 
from the front 
panel

Test page
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To print a Configuration page or PostScript Font List pages:

1 From the Ready screen, press the Menu button on the 
front panel twice.

2 Press the Enter button to display a list of available 
pages. 

3 Press the Continue/Forward button until you see 
Configuration Page or PostScript Font List in the window 
and press the Enter button.

The KX-P8420 prints a Configuration page or PostScript Font List 
pages.

Or press the Continue/Forward button or Cancel/Left button to 
display the name of the page you would like to print and press the 
Enter button. The KX-P8420 prints the page you selected.

Configuration page PostScript Font List pages
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This chapter describes how to connect your printer to a network by installing 
the network card (option). You can connect the printer to your network with 
thicknet, twisted pair, or thinnet. You can also connect your printer directly to 
a PC compatible through the parallel port.

This chapter provides information about:

• “Ethernet network connections” on page 46

• “Token Ring network connections” on page 48

• “Parallel cable connection” on page 49

• “Setting up TCP/IP clients for printing” on page 56

TCP/IP stands for Transmission Control Protocol/Internet Protocol. 

• “Setting up IPX (Novell) printing” on page 58

IPX stands for Internet Packet Exchange.

• “Setting up Windows 95 clients for WINS (SMB) printing” on pages 70

• “Setting up Windows NT 4.0 clients for WINS (SMB) printing” on page 73

SMB stands for Server Message Block.

After you have connected the printer to the network, follow the setup 
instructions in “Chapter 6 Setup from the Front Panel and WebSetup”.

Network connections
This section describes the types of network connections supported by the 
KX-P8420. Optional network cards are available from your Panasonic 
dealer. For more information on upgrade options, see “Chapter 9 Options”.

• Thinnet (thin coaxial cable or 10Base2)

Uses an external transceiver (media access unit, or MAU) to attach to the 
AUI (attachment unit interface) connector on the printer.

• Thicknet (thick coaxial cable or 10Base5)

Cable connects directly to the AUI connector on the printer.

• Twisted pair (Category 5 unshielded twisted pair cable or 100BaseTX)

Uses 8-pin RJ-45 connector that plugs into the RJ-45 socket on the 
printer.

NOTE:
• Category 3, unshielded twisted pair cable is supported on 10BaseT 

networks.

Ethernet network 
connections
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NOTE:
• Shut off the printer before connecting it to any network device. Only one 

Ethernet connection should be made to the printer at a time.

To connect a thinnet cable to the printer:

1 With the printer turned off, connect the MAU transceiver 
to the AUI connector on the back of the printer. Secure 
the connection using the slide latch on the AUI 
connector.

2 Connect the thinnet cable to the BNC connector on the 
transceiver.

3 Turn on the printer and then the computer.

To connect a thicknet cable to the printer:

1 With the printer turned off, connect the thicknet cable 
connector to the AUI connector on the back of the 
printer. 

2 Turn on the printer and then the computer.

AUI connector
Parallel port

RJ-45 socket
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To connect a twisted pair cable to the printer:

1 With the printer turned off, connect the RJ-45 cable to 
the RJ-45 socket on the back of the printer.

2 Turn on the printer and then the computer.

For Ethernet speed setting, see “Network Port Setup” on page 103.

The printer supports the following type of Token Ring connection:

• Unshielded twisted pair (Category 5 unshielded twisted pair cable or 
100BaseTX) cable that plugs into the UTP socket on the printer. 

• Shielded twisted pair (STP) cable that plugs into the DB 9-pin connector 
on the printer.

To connect UTP (Unshielded Twisted Pair) cable to the printer:

With the printer turned off, connect the cable from the Token 
Ring MAU (Media Attachment Unit) to the Token Ring card. 

NOTE:
• A Media Attachment Unit (MAU) is a network hub for a Token Ring 

Network.

STP (Shielded Twisted Pair) cable to the printer:

With the printer turned off, connect the STP cable from the 
Token Ring MAU to the DB-9 STP connector on the Token Ring 
card.

For Token Ring settings, see “Network Port Setup” on page 103.

Token Ring 
network 
connections

Parallel portDB-9 connector for STP 

RJ type connector for UTP cable
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Parallel cable connection
In addition to receiving print jobs over the network, the printer can accept 
print jobs directly from an IBM compatible computer through its high-speed, 
Centronics compatible parallel port. This connection is also advantageous 
for workstations on dedicated networks using protocols other than 
AppleTalk, TCP/IP, or IPX.

The parallel port connection can be used simultaneously with a network 
connection.

CAUTION:
• Always use a shielded interface cable. Use of an unshielded cable can 

result in radio interference with data.

NOTE:
• Printing through a serial port is not supported on Macintosh computers.

To connect a parallel cable to the printer:

With the printer and the computer turned off, attach the Centronics Type C 
parallel cable (not included) to the parallel port. 

1 Connect the other end of the cable to the parallel port on 
the computer.

2 Turn on the printer and turn on the computer.

For parallel port settings, see “Parallel Port Setup” on page 103.

Parallel port



50

Connecting the Printer to a Network

Setting up TCP/IP printing
TCP/IP provides network services for high-speed local and wide area 
networks and heterogeneous environments including PC compatibles, 
Macintosh computers, minicomputers, and mainframes running diverse 
operating systems. The printer supports the lpr protocol for printing over 
TCP/IP networks. Network users submit print jobs to a named printer. 
Workstations on a TCP/IP network can print directly to the printer, or can 
print to a Windows NT 4.0 server or UNIX workstation acting as a print 
server.

Before you install the printer on a TCP/IP network, you need to obtain a 
unique IP address. Contact your network administrator for this information.

To set up printing on a TCP/IP network, the network administrator must 
follow these steps:

To set up IP Address/Subnet mask on the KX-P8420:

1 From the Ready screen, press the Menu/Exit button on 
the front panel to access the printer setup menus.

2 Press the Continue/Forward button until you see 
Network Protocol Setup on the LCD. Press the Enter 
button to access the TCP/IP Setup menus.

In the next step you will enable TCP/IP network communication 
according to your network type.

3 Press Enter to advance to the Enable TCP/IP? screen. 
Press Enter to select Yes to enable Ethernet, and then 
press Enter again to advance to the Ethernet IP 
Address screen. Press Enter.

4 Use the Continue/Forward button to select a number in 
a valid, unique IP Address for the KX-P8420. Press 
Cancel/Left button to accept a number and move to the 
left—to the next number. 

NOTE:
• On the KX-P8420 printer, numbers are entered from right to left. 

Press the Continue /Forward button to scroll through numbers 
from 0 to 9. Press the Left/Cancel button to accept a number and 
move to the next. 

Setting up the 
printing 
environment
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5 When you have finished entering all numbers in the 
address, press Enter to advance to the Subnet Mask 
screen.

6 Use the Continue/Forward button to select a number 
as the Subnet Mask value for the KX-P8420. Press 
Cancel/Left button to accept a number and move to the 
left—to the next number. 

7 When you have finished entering all numbers, press 
Menu/Exit to return to Ready mode.

8 Specify the appropriate system and network settings in 
the printer’s Setup menus. 

See “Network Protocol Setup” on page 105 for details.

■ Setting up NIS server
If the site is using NIS (Network Information Services), a superuser must 
add the printer name and IP address to the system’s database of network 
printers.

1 Add the KX-P8420 to the network’s IP host table.

This step must be performed on the master NIS (server) machine. 
After adding the printer entry, the updated database must be 
released to network users.

2 For the printer name, specify the print server protocol, 
the print connection (queue), and the spool file.

3 Activate the printer connection.

Depending on your system, you may restart the printer daemon or 
tell the printer to accept print requests.

■ Print Queues
Print spooling is the process of sending a print jobs to a defined location on 
a hard disk, in this case the Print or Hold queues. Printers without a hard 
disk drive can only receive print jobs over the Direct connection. Jobs sent 
to the Direct connection are transferred from the computer to the printer’s 
RAM. 

NOTE:
• If the printer has a hard disk drive and 32MB of memory installed, Direct, 

Print, and Hold print connections are automatically available. If the printer 
does not have a hard disk drive, only the Direct connection is available.

32
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The lpr protocol is a printer spooling system. It is a set of programs that 
accepts printing requests from many users on a network, routes them to the 
proper print server (in this case, the KX-P8420), and accepts requests to 
display a queue’s status or to remove jobs from a queue.

The lpr system is included in the standard installation of Berkeley-based 
UNIX systems, SunOS 4, and Solaris.

Use the examples that follow as a guide in helping you set up your network 
for printing to the printer.

NOTE:
• In these examples, KX-P8420 is used as the printer name (the IP host 

name), and KX-P8420q is used to indicate the KX-P8420 Print queue.

Since the printer supports only one TCP/IP (lpr) connection at a time, you 
can use the same name for the hostname and the queuename. However, 
the examples indicate where you should make a distinction if you want to 
use different names.

To add the printer as a network printer to all UNIX systems:

1 Log in to your UNIX host as the root user.

2 Edit your /etc/hosts file to include the printer as a 
network device.

The following is a sample entry for the printer:

192.9.228.1<TAB>KX-P8420<TAB>#comments 

where <TAB> indicates that you press the tab key.

The IP address is followed by the official host name, and these are 
followed by aliases, if any. Type the entry exactly as shown, without 
a space before the IP address. 

NOTE:
• For sites that use DNS (Domain Name System) or that use NIS, 

NIS+, consult the documentation or the network administrator for 
instructions on publishing the printer entry.

3 Save and exit the hosts file.

4 Confirm the connection using the ping command. 

See “Verifying the TCP/IP network connection” on page 55.

UNIX server 
print queues
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5 If your UNIX system uses SunOS 4 or another BSD-
based variant, go to the next section.

If your system uses Solaris 2, follow the steps on page 54.

To set up printing on a UNIX system running SunOS 4 or another 
BSD based variant:

1 On each workstation that will print to the printer, log in to 
your UNIX host as the root user.

2 Create an entry for the printer in your /etc/printcap file.

The following is a sample printcap entry for the printer. Note that the 
remote host name you enter in the rm line must exactly match the 
name you entered in the /etc/hosts file.

KX-P8420q:\
:lp=:\
:rm=KX-P8420:\
:rp=xjprint:\
:lf=/var/spool/lpd/KX-P8420q/log:\
:sd=/var/spool/lpd/KX-P8420q:\
:mx#0:sf:sb

The spool directory KX-P8420q is specified here, and the directory 
itself is created in step 3. Similarly, the log file is specified here and 
created in step 4. The spool directory is write-protected (from 
everyone but a daemon user and daemon group); users cannot 
modify or remove files other than their own.

It is possible to set up to two additional printer entries, one with the 
rp name xjprint and one with the name xjhold. The rp name 
indicates the KX-P8420 queue to which jobs are sent when you 
print to the named printer. 

A printer entry with the rp name xjhold routes all jobs to the 
KX-P8420 Hold queue. Therefore, to print those jobs, they must be 
moved to the Print queue or deleted using Fiery WebSpooler.

NOTE:
• Printers without a hard disk drive and 32MB of memory can not 

use Print or Hold queues (rp name: xjprint and xjhold), they can 
only receive print jobs over the Direct connection. Use the rp 
name xjdirect if your KX-P8420 has no hard disk, or is configured 
with less than 32MB of memory.
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3 Create a spool directory for the printer in the /var/spool 
directory.

For example, enter the following:

mkdir -p /var/spool/lpd/KX-P8420q
chown daemon /var/spool/lpd/KX-P8420q

4 Create the log files.

For example, enter the following:

cp /dev/null /var/spool/lpd/KX-P8420q/log

5 Reboot the machine.

To set up printing on a UNIX system running Solaris 2:

1 On each workstation that will print to the printer, log into 
the UNIX system as the root user.

2 At the UNIX prompt, type lpsystem -t bsd KX-P8420
This tells your system that the printer is a print server of bsd 
(Berkeley Software Distribution) type.

3 Type lpadmin -p KX-P8420q -s KX-P8420\!xjdirect
This command creates an internal queue on the workstation and 
points it to the printer. The general format of this command is:

lpadmin -p <queuename> -s <hostname>\!xjdirect

NOTE:
• The name xjdirect after the exclamation point is for configuring 

the printer; it is an internal name that the printer requests. It must 
be xjdirect; it is not a user-selectable name. This is the only place 
where it is entered.

As with SunOS 4 or other BSD based systems, when printing to 
printers with a hard disk and a minimum of 32MB of memory it is 
possible to configure up to two additional printer entries, one with 
the rp name xjprint and one with the rp name xjhold (see page 53).

4 Type accept KX-P8420q
This command tells the printer to accept print requests from your 
workstation. You are now ready to print from the workstation to the 
printer.

5 Type enable KX-P8420q
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Before a device on a TCP/IP network can send print jobs to the printer, the 
printer must be given a valid IP address and subnet mask, as well as a 
gateway address, if applicable. The printer is given these addresses in the 
printer’s Network Protocol Setup. The IP address is used on all TCP/IP 
networks and must always be assigned before the printer can be verified 
across the network.

Because TCP/IP networks require some UNIX setup by the network 
administrator, you may not be able to send a test page from the driver 
across the network to the printer immediately after installation. The following 
procedure enables you to verify that there is a proper connection between 
the printer and the network without using the printer driver to print a test 
page. Before you begin this procedure, verify that the printer is functioning 
by printing a page from the printer’s ROM.

For step by step instructions, see “Printing pages from the front panel” on 
page 44.

Once the printer’s TCP/IP setup is complete, you can verify the availability 
of the printer using the ping command from the DOS prompt with Windows 
95, from the Command prompt with Windows NT 4.0 or from UNIX.

To verify the TCP/IP connection:

To see if the printer responds to its address, use the ping 
command. 

Use the format:

ping <IP address>

Use the printer IP address assigned in Network Protocol Setup. After the 
printer has been given a hostname by your network administrator, you can 
also ping the name you gave it:

ping <hostname>

The server should respond with a message such as:

<IP address> is alive.

Some systems will respond with a continuous display of output from the IP 
address. To stop the output, type Control-C

Verifying the 
TCP/IP network 
connection
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If the printer is being added to an existing network, each TCP/IP client is 
already running TCP/IP client software.

The KX-P8420 supports TCP/IP client software on UNIX workstations, PC 
compatibles, and Macintosh computers. With Macintosh computers 
however, it is easiest to use the built-in AppleTalk protocol to communicate 
directly with the printer.

If the client workstation is a PC running Windows, set up the printer as a 
Windows PostScript printer by installing the PostScript printer driver, as 
described in Chapter 4. For setting up your networking software, see the 
documentation for your networking environment.

Fiery WebTools software comes pre-installed on the KX-P8420. 
Fiery WebTools include: WebSpooler, Status, WebDownloader, WebSetup 
and WebLink.

When TCP/IP is enabled for the printer in Network Protocol Setup, 
Fiery WebTools are immediately available to clients that:

• Are connected to a TCP/IP network with a consistent set of IP addresses, 
one for the printer and one for each computer connect to the printer. 

• Have an Internet connection and a Java enabled Web browser. 

The recommended browsers are:

• Netscape Navigator 3.04 for Macintosh computers, 

• Microsoft Internet Explorer 4.0.1 SP1 or Netscape Communicator 4.0.4 
for Windows computers.

NOTE:
• Microsoft Internet Explorer 3.x does not support the WebDownloader.

Netscape and Microsoft continue to release frequent updates to their 
browsers. As support cannot be guaranteed for all versions, use the 
versions specified above for best results.

To access Fiery WebTools, enter the IP address or DNS name of the 
KX-P8420 as a URL in the Internet browser. For more information, see 
page 67.

Setting up TCP/
IP clients for 
printing

Setting up TCP/
IP clients for 
running 
Fiery WebTools
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Once the printer has been properly installed on the TCP/IP network, users 
should be able to send print jobs to the KX-P8420 from most applications. 
UNIX clients also commonly use UNIX printing commands to print 
PostScript files and text files to the printer.

For information on printing PostScript files and text files using UNIX 
commands, see Chapter 3 of Drivers and Utilities Reference Guide.

If you have superuser privileges you can remove any lpd jobs from the 
printer queue; removing your own jobs doesn’t require special privileges.

To remove jobs from the printer queue:

On a UNIX system running SunOS 4 or other BSD-based 
variant, use the lprm command to remove jobs from the queue.

To remove job number 123 from the print queue of your KX-P8420 named 
printer, you would type:

lprm -P<printername> <job #…>

or, for example: lprm -PKX-P8420 123

The lprm command reports the names of any files it removes.

To determine the job number, use the lpq command described below.

lpq -p<printername>

On a UNIX system running Solaris 2, use the cancel command 
to remove jobs from the queue.

Type:

cancel <job ID>

For example, to remove a job whose ID is printer-123 from the print queue 
of your KX-P8420, type:

cancel printer-123

To find out a print job’s job ID, use the lpstat command described below:

On a UNIX system running Solaris 2, use the lpstat command 
to see printer jobs in the queue.

lpstat -o <queuename>

For example, if your printer queue is named KX-P8420q, type:

lpstat -o KX-P8420q

The returned list of jobs includes each job ID.

Once lpr print jobs are spooled to the printer’s hard disk, you can use 
WebSpooler to monitor print jobs.

Printing and 
administering 
print jobs
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Setting up IPX (Novell) printing
IPX, Novell’s Internetwork Packet Exchange protocol, runs on networks that 
include a Novell NetWare server. The server, typically a dedicated PC, is 
usually configured to control workstation access to shared resources. In 
addition to other services, NetWare servers use IPX protocols to provide 
spooling, queue management, and print services to computers (including 
Macintosh, DOS, UNIX, and VAX) whose operating software is compatible 
with IPX protocols. 

This section describes network setup for an IPX (Novell) network. 

NetWare file servers support the creation of print queues, storage areas for 
print jobs. When a user on a network workstation prints a job, the job is sent 
to a print queue on the NetWare server. The job is spooled to the NetWare 
file server disk, freeing up the workstation.

The queues on the NetWare server must be named to match the Direct 
connection and Print queue on the KX-P8420. The NetWare queue names 
should be given an extension corresponding to the KX-P8420 printing 
connection, as follows:

_print
_hold
_direct

NOTE:
• The NetWare queues names must be given the above all lowercase 

English extension (_print, _hold or _direct), even if any language’s 
NetWare server is used.

When the KX-P8420 is configured to connect to a NetWare server, it polls 
the NetWare server for jobs in each of its queues. If jobs are found, they are 
transferred over the network to the matching connection: Print to Print, 
Direct to Direct. While a job is processed and printed, a record of the job is 
being created. You can access the Job Log containing these records at any 
time.

When the printer is connected to a NetWare print queue that is defined on 
the NetWare server, the printer polls the queue for jobs and receives them 
over the network for immediate processing and printing. All printer jobs are 
sent from the printer queue on the NetWare server to the KX-P8420.

NOTE:
• It is not recommended to connect KX-P8420 directly to NetWare server 

via LPT port. It may cause unexpected print result.

Overview of IPX 
printing to the 
KX-P8420
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To set up network printing, enable IPX/SPX Setup from the printer’s front 
panel (see “Network Protocol Setup” on page 105), and set up the PServer 
using WebSetup after configuring the NetWare server (see “PServer Setup 
tab” on page 116). 

This section explains how to set up the NetWare server so that networked 
users can print to the printer from their workstations. There are two stages 
to this setup:

• The network administrator must set up a print queue on the NetWare 
server so users can print to it, and the printer can receive print jobs 
from it.

• Optionally, the administrator can set up the server for network installation 
of PostScript printer drivers on client workstations.

Before configuring a NetWare file server for printing to the KX-P8420, make 
sure that it is connected to a functioning IPX network. Then, log in as the 
supervisor on a PC connected to the NetWare file server, and configure the 
file server as described in the following sections.

Before you begin, you’ll need to determine the following names:

• The name of the NetWare file server on which you will define the printer 
as a new print server.

• The name of the NetWare print server. This name is used for 
communication between the printer and the NetWare file server.

• The name to assign to the KX-P8420 Direct, Print or Hold queue. If you 
are defining a Hold queue, the last five characters must be _hold. You 
need to set up at least one print queue on the NetWare server for jobs 
that will be printed by the printer. Users will see and print to the name you 
assign to the Print queue.

Names should be as brief and descriptive as possible. Server names 
cannot begin with a period and cannot include spaces or punctuation 
characters other than periods. 

• To complete network setup, you will need to log in to the NetWare file 
server and the new print server from the printer. You will need a login 
name and, if access to the server is restricted, a login password.

Configuring the 
NetWare server
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■ Setting the NetWare 4.x bindery context
Novell 4.x servers use a different environment setup than Novell 3.1x 
servers. (If your server is using NetWare 3.x, proceed to “Setting up a 
KX-P8420 print queue” on page 63.) The native structure for Novell 4.x 
objects is known as Novell Directory Services (NDS). To provide backward 
compatibility with Novell 3.1x services, Novell 4.x servers use Bindery 
Emulation to “act” like a Novell 3.1x server.

To set up the NetWare 4.x server for printing to the printer, you must do the 
following:

• Determine the NDS path to the container in which the print server and the 
print queue for the printer will be created. 

The container defines the bindery context for your network structure. 
Network devices that are not NetWare 4.x-aware need a bindery context 
to work with NetWare 4.x.

• Edit the network startup file to set the bindery context.

• Activate the new bindery context.

This section describes the second and third steps. Given the variety of 
possible network structures, we can’t suggest a bindery context that 
applies to every network.

To set the bindery context:

1 At the NetWare drive prompt, change directories to the 
System directory, and type rconsole

2 Establish a connection with the server that will have the 
printer queue.

3 At the NetWare prompt type load install
The NetWare Server Installation window is displayed.
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4 Use the down arrow key to select Maintenance/
Selective Install.
The Installation Options menu is displayed.

5 Select NCF Files Options.

6 In the menu of available NCF files, select EDIT 
AUTOEXEC.NCF file.
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7 Type a new line anywhere in the file as follows:

set Bindery Context = (Enter your bindery context here)

NOTE:
• To the right of the equals sign, type the bindery context obtained 

from the system administrator. 

8 Press Esc to close the window, and save changes.

9 Proceed to the next section.

To activate the bindery context:

1 If you cannot reboot the NetWare server at this point, 
type the set command manually at the server’s 
command prompt.

Use the same command that you entered in the autoexec.ncf file 
(see step 7 in the previous procedure).

2 If you can reboot the NetWare server, the set command 
is loaded automatically.

You are ready to set up the KX-P8420 print server and print queue. 
See the next section for details.
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The NetWare print server and print queue are created and configured from 
NetWare Print Console, a NetWare utility that is stored in NetWare’s 
PUBLIC directory.

To set up the NetWare server for printing to the KX-P8420:

1 Log in to the NetWare server as the Supervisor.

2 At the NetWare MS-DOS prompt, type pconsole
The Available Options menu is displayed.

3 Select Change Current File Server and press the 
Enter key.

4 Using the arrow keys, select the file server name and 
press the Enter key.

You must select this file server later as the NetWare File Server in 
WebSetup>Network Setup.

5 Select Print Server Information from the Available 
Options menu.

Setting up a 
KX-P8420 
print queue
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6 Press the Insert key, type a name for the new print 
server, and press the Enter key. Then press the Esc 
key.

You must select this print server later as the NetWare Print Server 
in WebSetup>Network Setup.

7 Select Print Queue Information from the Available 
Options menu.

8 Press the Insert key and type a name for a new print 
queue. Press the Enter key.

The print queue name you entered will be highlighted in the Print 
Queues list.

If the print server manages more than one print queue, you’ll have 
to select this name later in WebSetup>Network Setup.
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9 Make sure the print queue name you created is selected 
in the Print Queues menu, and press the Enter key. 

The Print Queue Information menu is displayed.

10 In the Print Queue Information menu, select Queue 
Servers, and press the Enter key.

A blank Queue Servers list is displayed.

11 Press the Insert key.

The Queue Server Candidates list is displayed.

12 Use the arrow keys to select the name of the print server 
you created in step 6 and press the Enter key.

The server name you select will appear in the Queue Servers list.

You have associated the selected printer queue with the print server 
you created in step 6.

13 Press the Esc key to exit all PCONSOLE windows.

14 Select Yes or press the Return key to save changes to 
PCONSOLE.

Queue Server Candidates

PARALLEL
(Print Server)Color_Printer
(Print Server)

Queue Servers
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Before setting up client workstations, make sure you perform Network 
Setup on the printer, and that the settings reflect the entities you created in 
PCONSOLE.

Client setup has two parts:

• Install the PS printer driver on each Windows workstation.

• Configure the printer driver to print to a print queue on a Novell file server.

For instructions on installing the appropriate printer driver for your system 
see “Chapter 4 Installing Software for Windows”.

For instructions on configuring the printer driver to print to a Novell file 
server print queue, see page 77 for Windows 95, or page 89 for 
Windows 3.1.

Using AppleTalk with Macintosh computers on an IPX 
(Novell) network

Macintosh users on an IPX network can print to the printer in two ways:

• Directly, using AppleTalk and bypassing the NetWare server

• Through a NetWare server running NetWare for Macintosh

Since the printer supports both AppleTalk and IPX protocols at the same 
time, it’s not necessary to use the second option. However, a network 
administrator may choose to route all print jobs through a server.

NOTES:NOTES:NOTES:
• The printer can be attached to only one NetWare server at a time.

• Printing via the AppleTalk port of Windows NT 4.0 is not recommended as 
it may cause additional, unnecessary pages to be printed.

■ Printing directly to the printer
Due to the layered design of networks, data can be transmitted using more 
than one network protocol. When Macintosh computers are connected to an 
IPX network, they can continue to transmit data over Ethernet cable using 
AppleTalk protocols. If the printer is on the same network, Macintosh 
computers can see and print to the printer, provided that AppleTalk is 
enabled on the Macintosh and in Network Protocol Setup.

Setting up 
NetWare Windows 
clients
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Setting up Fiery WebTools
Fiery WebTools allow you to manage your KX-P8420 remotely from the 
Internet or from your company’s intranet. The KX-P8420 has its own home 
page, from which you are able to select from a variety of functions including 
Status, Fiery WebSpooler, WebLink, Fiery WebDownloader, and 
Fiery WebSetup. 

IMPORTANT:
• Before you can send jobs to the printer, you must use Fiery WebSetup to 

complete the process of configuring Setup options, as described starting 
on page 108. Therefore, you must complete the procedures described in 
this section and in “Completing setup from Fiery WebSetup” on page 108 
before you can send jobs to the printer.

For information on using Fiery WebTools (other than Fiery WebSetup), see 
Drivers and Utilities Reference Guide.

In order for network users to access and use Fiery WebTools, you need to 
set network communication options in Network Protocol Setup on the front 
panel. See “Setting up the printing environment” on page 50. You also need 
to prepare each user’s workstation to communicate with the KX-P8420 
using Fiery WebTools over the Internet or intranet. Once the initial Setup 
has been performed from the printer’s front panel, you must complete the 
Setup configuration from Fiery WebSetup.

In order for client workstations to access Fiery WebTools, they must use a 
Web browser. The recommended browser versions are:

• Netscape Navigator 3.04 for Macintosh computers, 

• Microsoft Internet Explorer 4.0.1 SP1 or Netscape Communicator 4.0.4 
for Windows computers.

NOTES:NOTES:NOTES:
• Microsoft Internet Explorer 3.x does not support the Fiery 

WebDownloader.

• Netscape and Microsoft continue to release frequent updates to their 
browsers. As support cannot be guaranteed for all versions, use the 
versions specified above for best results.

• Accessing to WebSetup via Netscape Navigator 3.04 for Macintosh 
Computers is slow and not recommended.

• It is not recommended to open WebTools at several locations 
simultaneously because it might adversely affect network printing.
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• If Java Applet is not set to Enable, you can not access the Fiery 
WebTools. Follow the next steps:

Netscape 4.x

1. Select Preferences in the Edit menu. 
The Preferences window appears.

2. Select Advanced in the Category.

3. Click the boxes next to Enable Java and Enable JavaScript.

4. Click OK.

Netscape 3.x

1. Select Network Preferences in the Options menu. 
The Preferences window appears.

2. Click the Languages tab.

3. Click the boxes next to Enable Java, and Enable JavaScript.

4. Click OK.

Internet Explorer 4.x

1. Select Internet Options in the View menu.

2. Click the Security tab.

3. Click the circle next to Custom (for expert users) in the Local Intranet 
zone.

4. Click Settings button. 
The Security Settings window appears.

5. Click Custom in Java permissions, and click Java Custom Settings 
button. 
The Local intranet zone window appears.

6. Click the Edit Permissions tab, and click Enable in Run Unsigned 
Content.

7. Click OK three times.
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Instructions below apply to computers using Ethernet protocols.

To use Fiery WebTools on each client workstation:

1 Enable TCP/IP on the KX-P8420.

2 Make sure the workstation has a valid, unique 
IP address.

3 Make sure the workstation is installed with an Internet 
browser.

4 Launch the Internet browser.

5 Enter the IP address or DNS name of the printer in the 
browser’s URL line.

The printer’s home page appears. For more information on using 
Fiery WebTools, see page 108 and “Chapter 4 Managing Print 
Jobs” in Drivers and Utilities Reference Guide.
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Setting up Windows 95 clients for WINS (SMB) printing
The following instructions describe printing to a network port using the 
Details tab of the Printer Properties dialog. You must specify the option 
settings including Server Name in the Service Setup screen, before doing 
WINS (SMB) printing. See “Service Setup tab” on page 117.

NOTE:
• The Details tab of the Printer Properties dialog is not available when the 

dialog is accessed using File>Print from within applications. This tab 
appears only when the Printer Properties dialog is accessed via the 
Printers folder.

To set up WINS (SMB) printing on Windows 95:

1 From the Start menu, choose Settings, and click 
Printers.

2 Select the Panasonic KX-P8420 printer icon, and choose 
Properties from the File menu.

3 Click the Details tab in the Properties window and click 
Add Port.

4 In the Add Port dialog box, click Network, and click 
Browse to display your network environment.
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5 Expand the levels to locate your printer and the queue 
you want to print to.

If your printer has a hard disk drive and 32MB of memory, three 
connections will automatically be created when the KX-P8420 
printer driver is installed. These connections are represented on the 
network by the Direct, Print and Hold printer icons. If your printer 
does not have a hard disk drive and 32MB of memory, only the 
Direct printer icon will be available.

If hold queue is specified, all jobs sent to your printer will be held on 
the printer’s hard disk and will be visible in Windows spooler until 
they are released for printing, or deleted with Fiery WebSpooler.

The printer you are browsing for is the SMB Name Server. If you do 
not know the name of the SMB Name Server and SMB printing has 
been enabled on the printer, refer to the printer’s Configuration 
page for this information.

For instructions on printing a Configuration page, see “Printing 
pages from the front panel” on page 44.

NOTE:
• If the local network does not include a WINS server, your printer 

may not be visible in Browse dialog box. In this case, you must 
type the correct path for the print connection to which you want to 
print in the box below “Specify the network path to the printer” of 
Add Port dialog box (ex\\KX-P8420\direct).

6 Under the printer’s name, select the queue you wish to 
print to and click OK.

32
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7 In the Add Port dialog box, verify that the network path 
is correct and click OK.

8 To confirm the connection, click the General tab in the 
Properties dialog box.

9 Click Print Test Page and click OK.

If the test page prints successfully, you are ready to print from the 
computer.
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Setting up Windows NT 4.0 clients for WINS (SMB) 
printing

The following instructions describe printing to a network port using the 
Details tab of the Printer Properties dialog. 

The Details tab of the Printer Properties dialog is not available when the 
dialog is accessed using File>Print from within applications. This tab 
appears only when the Printer Properties dialog is accessed via the Printers 
folder.

To set up WINS (SMB) printing on Windows NT 4.0:

1 From the Start menu, choose Settings, and click 
Printers.

2 Select the Panasonic KX-P8420 printer icon, and choose 
Properties from the File menu.

3 Click the Ports tab in the Properties window and click 
Add Port.

4 In the Printer Ports dialog box, select Local Port, and 
then click New Port.
The Port Name dialog box appears.

5 Enter the name of the printer port to print to, for 
example: \\KX-P8420\direct and then click OK. 

6 To confirm the connection, click the General tab in the 
Printer Properties dialog box.

7 Click Print Test Page and click OK.

If the test page prints successfully, you are ready to print from the 
computer.
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This chapter describes installing software and setting up printing from a 
Windows-based computer running Windows 95, Windows 3.1, or 
Windows NT 4.0.

See the Chapter 3 or instructions on how to connect the printer to a 
computer or to a network.

General steps
The general steps for installing the KX-P8420 user software from the CD 
are:

• Install the PostScript printer driver.

• Set up the printer driver to communicate with the KX-P8420 over the 
network or through the parallel port.

Instructions for installing the PostScript printer driver for Windows 95 are 
given below. Instructions for installing the PostScript printer driver for 
Windows 3.1 and Windows NT 4.0 systems are given later in this chapter.

If you are setting up a printer that will be shared by many users, and you 
would like to make the printer drivers available to others, you can exit the 
installer program and manually copy the printer drivers and files from the 
KX-P8420 Driver & Utility CD-ROM to the location of your choice. Use this 
method, for example, to copy printer drivers to a server on your network, or 
to a floppy disk.

NOTE:
• Windows 95 Plug and Play specifies the automatic detection of any new 

hardware installed on your computer. If your printer is connected to the 
computer via the parallel port and it is powered on when your computer is 
restarted, a dialog box indicating new hardware has been detected will 
appear, prompting you to install the manufacturer’s software. Install the 
printer driver for your printer by selecting Other Location, and navigating 
to the PostScript printer driver directory on the KX-P8420 Driver & Utility 
CD-ROM. When you have installed the printer driver of your choice, be 
sure to specify optional devices installed on your printer to enable 
features related to their use.
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Installing the PostScript printer driver for Windows
To set up the KX-P8420 as a PostScript printer you must install the 
PostScript printer driver v4.2 for Windows 95. This file is included on the 
KX-P8420 Driver & Utility CD-ROM.

If autorun is enabled on your computer, when the KX-P8420 Driver & Utility 
CD-ROM is inserted in the CD-ROM drive the installer runs automatically, 
allowing you to specify which files to install on your computer.

NOTE:
• If autorun is not enabled, you can run the installer by double-clicking the 

CD-ROM drive icon in My Computer (Windows 95), or by double-clicking 
the Setup.exe file in the installer folder on the KX-P8420 Driver & Utility 
CD-ROM. 

To install the PostScript printer driver:

1 Insert the KX-P8420 Driver & Utility CD-ROM in your 
CD-ROM drive.

The installer is launched automatically.

2 In the installer screens, select the Typical, Compact, or 
Custom installation option.

3 Follow the instructions that appears on the screen.

A message appears on the screen to indicate installation is 
complete.

Choose 
this

To install

Typical The Adobe PostScript printer driver and the 
KX-P8420 PPD.

Also copies the Adobe Type Manager installer 
(Windows 95 only) and Adobe PostScript 3 fonts 
to your hard disk.

Compact The Adobe PostScript printer driver and the 
KX-P8420 PPD.

Custom Only the files you select—copies them to your 
hard disk.

Installing the 
PostScript printer 
driver for 
Windows 95
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When the printer driver is installed, specify the optional devices installed on 
your printer to enable use of options relating to those devices.

To specify devices installed on the KX-P8420:

1 From the Start menu, choose Settings >Printers.

2 Select the Panasonic KX-P8420 printer icon and select 
Properties from the File menu.

3 Click the Device Options >Options tab, and specify the 
devices installed on the printer.

2nd Feeder—Select if an optional 500 sheet feeder is installed.

Hard Disk—Select if an optional hard disk drive is installed.

4 For each, select from the Available Options list and 
click Add to move the option to the Installed Options 
list. 

5 Click Apply.

Specifying installed 
devices
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To print from Windows 95 you need to:

• Set up the KX-P8420 to accept print jobs from your computer.

• Configure a port on each Windows 95 computer for the network or 
connection type.

■ Setting up parallel printing with Windows 95
The following procedure describes how to prepare the computer for parallel 
printing.

To install the printer for parallel printing:

1 Click the Start button, select Settings, and click 
Printers.

2 Click the Panasonic KX-P8420 printer icon and select 
Properties from the File menu.

3 Click the Details tab and make sure the box “Print to the 
following port:” reads as follows: LPT 1 (Printer Port) or 
LPT1 (ECP Printer Port).

4 Click Apply.

You are now ready to print from your applications to the KX-P8420 
with the parallel port. To confirm the connection, print a test page. 

5 Click the General tab.

6 Click the Print Test Page button to print a test page.

■ Setting up IPX (Novell) printing with Windows 95

The following procedure describes how to prepare the computer for printing 
using IPX protocols.

Before you begin:

Verify the KX-P8420 has been configured for Novell printing in 
Network Protocol Setup.

For more information about setting up the printer for IPX (Novell) printing, 
see “Setting up IPX (Novell) printing” on page 58.

Completing the 
connection for 
Windows 95 
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To set up IPX (Novell) printing:

1 Click the Start button, select Settings, and click 
Control Panel.

2 Double-click the Network icon.

Make sure that IPX/SPX-compatible Protocol is listed in the 
Installed Network Components section. For instructions, see your 
Windows 95 documentation.

3 Close the Network window and the Control Panel 
window.

4 Click the Start button, select Settings, and then click 
Printers.

5 Click the Panasonic KX-P8420 printer icon, and select 
Properties from the File menu (or right-click the printer 
icon, and left-click Properties).

6 Click the Details tab, and click Add Port.
A list of connection options is displayed.

7 In the Add Port dialog box, click Network and specify 
the network path, or click Browse for a display of your 
network environment.

8 If you are using a NetWare file server, double-click the 
icon of the server you want to use for printing to the 
KX-P8420 and click OK. 

9 Click the printer icon labeled with the NetWare print 
queue you will use and click OK.

10 In the Add Port dialog box, verify that the network path 
is updated, and click OK.

To confirm the connection, you can print a Windows 95 test page.

11 Click the General tab in the Properties dialog box, and 
click Print Test Page.

You are ready to print to the KX-P8420 from Windows applications. 
When you select Print, jobs are routed to the print queue on the 
NetWare file server, and then sent to the KX-P8420. 
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PostScript printing with Windows NT 4.0 begins with installation of the 
PostScript printer driver for Windows NT 4.0 and the KX-P8420 printer PPD, 
and finishes by configuring a particular type of connection between the 
workstation and the KX-P8420. The PostScript printer driver for 
Windows NT 4.0 is not included on the KX-P8420 Driver & Utility CD-ROM, 
accordingly, if the KX-P8420 is the first PostScript printer to be used with 
your system, you will need to install this printer driver from your installation 
CD or disk for Windows NT 4.0. With this version of software, KX-P8420 
files support Intel-based Windows NT 4.0.

Adding a printer to a local system requires that you log in to your local 
workstation (not the network server domain) for Windows NT 4.0 and that 
you are a member of the Administrators group. The instructions below 
describe installing a printer locally. The procedure for adding a network 
printer is similar to adding a port. For more information, see step 6 in the 
“Setting up TCP/IP and LPR printing with Windows NT 4.0” on page 83.

If autorun is enabled on your computer, when the KX-P8420 Driver & Utility 
CD-ROM is inserted in the CD-ROM drive, the installer on the 
KX-P8420 Driver & Utility CD-ROM runs automatically, allowing you to 
specify the files to install on your computer.

NOTE:
• If autorun is not enabled, you can run the installer by double-clicking the 

CD-ROM drive icon in My Computer, or by double-clicking the Setup.exe 
file in the Installer folder on the KX-P8420 Driver & Utility CD-ROM. If 
optional devices are installed on your printer, follow the instructions in the 
next section as well.

Setting up 
PostScript printing 
with Windows NT 
4.0
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To install the KX-P8420 as a local PostScript printer:

1 Insert the KX-P8420 Driver & Utility CD-ROM in your 
CD-ROM drive.

2 Select the Typical, Compact, or Custom installation 
option.

If this is the first PostScript printer installed on your computer and you 
attempt to install the KX-P8420 PPD, the Files Needed dialog box will 
appear, prompting you to locate the PostScript driver PSCRIPT.DLL for 
Windows NT 4.0.

To complete the installation if PostScript files are needed:

1 Eject the KX-P8420 Driver & Utility CD-ROM and 
insert the Installation CD for Windows NT 4.0.

2 In the text field, type the name of the CD-ROM drive (for 
example, D:\), and click Browse.

3 Browse to the i386 (the directory containing the 
PostScript driver).

4 Click OK, and then click OK in the Files Needed dialog 
box.

When installation is complete, the Printers window appears with an 
icon for the newly installed printer.

Choose this To install

Typical The Adobe PostScript printer driver and the 
KX-P8420 PPD.

Also copies the Adobe Type Manager installer 
(Windows 95 only) and Adobe PostScript 3 fonts 
to your hard disk.

Compact The Adobe PostScript printer driver and the 
KX-P8420 PPD.

Custom Only the files you select—copies them to your 
hard disk.

Installing the 
PostScript 
printer driver for 
Windows NT 4.0
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When the printer driver is installed, specify the optional devices installed on 
your printer to enable use of options relating to those devices.

To specify options installed on the KX-P8420:

1 Select Settings >Printers from the Start menu.

2 Click the Panasonic KX-P8420 printer icon and select 
Properties from the File menu.

3 Click the Device Settings tab, and scroll down to 
Installable Options.

4 Configure the following options to correspond with the 
features installed on the printer:

2nd Feeder—Select if an optional 500 sheet feeder is installed.

Hard Disk—Select if an optional hard disk drive is installed.

5 To select an option click its name, and then select 
Installed in the “Change ‘…’ Setting” area at the 
bottom of the dialog box.

6 Click OK.

Specifying 
installed devices
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To print from Windows NT 4.0 you need to:

• Set up network servers, if any.

• Set up the KX-P8420 to accept print jobs from your computer.

• Configure a port on each computer with Windows NT 4.0 for the network 
or connection type.

■ Setting up parallel printing on Windows NT 4.0
Once you have installed the PostScript printer driver for Windows NT 4.0 
complete the setup for parallel printing as follows:

To set up parallel printing:

1 Click the Start button, select Settings, and then click 
Printers.

2 Double-click the Panasonic KX-P8420 printer icon, and 
select Properties from the Printer menu.

In the Ports tab, confirm that LPT1 (Local Port) is checked. The 
KX-P8420 is ready to accept parallel print jobs from your computer. 

3 Select the General tab, and click Print Test Page.

When you select Print, your files are sent over the parallel port 
connection to the KX-P8420.

4 Select the Sharing tab if you want to share the printer 
with network users. Click Shared, and enter a share 
name.

Select the operating system or systems used by your network 
clients from the Alternate Drivers box if you want to install a printer 
driver that those clients can automatically download when they 
connect.

5 Click OK. In the dialog box that appears, navigate to the 
location of the alternate printer driver to install.

6 Click OK to exit the Printer Properties dialog box.

Completing the 
connection for 
Windows NT 4.0
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■ Setting up TCP/IP and LPR printing with Windows NT 4.0
Once you have installed the PostScript driver for Windows NT 4.0 complete 
the setup for the TCP/IP and lpr connection as follows:

• Prepare the KX-P8420 to accept print jobs using TCP/IP and lpr 
protocols.

• Configure the workstation for the TCP/IP connection.

Before you continue, ask the system administrator for the IP address 
assigned to the KX-P8420 and the subnet mask as well as gateway 
address, if they are used.

To prepare the KX-P8420 for TCP/IP and LPR printing:

1 With the KX-P8420 turned off, connect it to the network.

2 Turn on the printer.

Wait until Ready or Ready(Sleep) is displayed.

3 Press the Menu/Exit button of the printer’s front panel.

4 Press the Continue/Forward or Cancel/Left button to 
advance to Network Protocol Setup menu.

5 Enable TCP/IP and enter the appropriate settings for 
IP address, subnet mask and gateway address.

For details, see “Network Protocol Setup” on page 105.

6 Press the Menu/Exit button to exit the setup menus.

The TCP/IP Protocol and Microsoft TCP/IP Printing software should already 
be installed on the workstation for Windows NT 4.0.
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To set up TCP/IP and LPR printing for Windows NT 4.0:

1 Click the Start button, select Settings, and then click 
Printers.

2 Click the Panasonic KX-P8420 printer icon, and select 
Properties from the File menu (or right-click the printer 
icon, and left-click Properties).

3 Click the Ports tab.

4 Click Add Port.
The available port types are displayed.
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5 Select LPR Port and click New Port.
If the LPR port is not listed, install the TCP/IP protocols and 
Microsoft TCP/IP Printing. For details, see your documentation for 
Windows NT 4.0.

6 In the Name or address of server providing lpd box of 
the Add LPR compatible printer dialog box, enter the 
IP address of the KX-P8420. 

If your network uses Domain Name Services (DNS), enter the DNS 
name assigned to the KX-P8420 instead of the IP address.

7 Press Tab and type the internal name of the KX-P8420 
in lowercase letters.

NOTES:
• Type this name exactly as shown; it is required for 

communication with the printer.

The name must be one of these:

xjdirect
xjhold
xjprint 

• Use the last two internal names only if your printer has a hard 
disk drive and a minimum of 32MB of memory.

8 Click OK.

The workstation checks the address or DNS name that you entered 
and notifies you if it cannot resolve the address.

9 Click Close of the Printer Ports window.

The Ports property tab shows the new port configuration.

10 Click OK to close the Panasonic KX-P8420 Properties 
dialog box.

The new port has been configured. You should now print a test 
page to verify the connection.

11 Open the Panasonic KX-P8420 Properties dialog box. 
Click the General tab and click Print Test Page.

When you print, your files are sent over the LPR Port connection to 
the KX-P8420.

12 Click OK to exit.

32
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The Adobe PostScript printer driver for Windows 3.1 is included on the 
KX-P8420 Driver & Utility CD-ROM.

To install the Adobe PostScript printer driver:

1 Start Windows and exit any applications that start 
automatically.

2 Insert the KX-P8420 Driver & Utility CD-ROM into the 
CD-ROM drive.

3 In the Main window, double-click the Control Panel icon 
and double-click the Printers icon.

4 In the Printers dialog box, click Add, and then click 
Install.

5 In the Install Driver dialog box, click Browse.

6 To install the Adobe PostScript printer driver navigate to: 
d:english\prntdrvr\win3x. Click OK.

7 In the Install Driver dialog box that appears, verify the 
path and click OK.

8 Select the Panasonic KX-P8420 from the Add 
Unlisted or Updated Printer dialog box and click OK.

The necessary files are installed from the KX-P8420 Driver & Utility 
CD-ROM to your hard disk. When installation is complete, the 
Panasonic KX-P8420 on LPT1: appears in the Installed Printers list.

NOTE:
• If you fail to install Windows 3.1 driver after the message “This driver 

cannot be updated because it is currently being used by Windows. Wait 
until Windows is finished, using the driver and then try again” is shown. 
Please remove the file ctl3dv2.dll under \Windows\system directly from 
MS-DOS®*1 prompt and try to install again.

*1 Microsoft® MS-DOS® operating system (hereafter MS-DOS)

Installing the 
PostScript 
printer driver for 
Windows 3.1
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When the printer driver is installed, specify the optional devices installed on 
your printer. This will enable use of options relating to those devices.

To specify options installed on the KX-P8420:

1 In the Control Panel window, double-click the Printers 
icon.

2 In the Printers dialog box, select the Panasonic 
KX-P8420 on LPT1: in the Installed Printers list, and 
click Setup.

3 In the Panasonic KX-P8420 on LPT1: dialog box, click 
the Features tab.

4 Specify the options that correspond to the devices 
installed on the printer.

5 For each option installed on the printer, select Installed 
from the corresponding menu. 

2nd Feeder—Select if an optional 500 sheet feeder is installed.

Hard Disk—Select if an optional hard disk drive is installed.

6 Click OK to activate the current settings.

Specifying 
installed devices
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To print from Windows 3.1 you need to:

• Set up the KX-P8420 to accept print jobs from your computer.

• Configure a port on each Windows 3.1 computer for the network or 
connection type.

■ Selecting a printer port 
When you install a printer, Windows assigns it to a default parallel printer 
port. If the KX-P8420 printer is connected to your computer through a 
network or you want to assign it to a different port, you need to change the 
port assignment. For information on which port to use, see your system 
administrator.

To select a printer port:

1 In the Control Panel window, double-click the Printers 
icon.

2 In the Printers window, select the Panasonic 
KX-P8420 on LPT1: in the Installed Printers list box.

3 Click Connect.
The Connect window appears.

4 Connect the KX-P8420 to the same port as your 
network.

To print to a file, select FILE. 

Printing to a file is useful if the KX-P8420 is not at your site. 
However, if you select the FILE port, you cannot print to a printer 
until you select a network or printer port. (In some applications, you 
can select the FILE port from the application’s Print dialog box; this 
is preferable for temporary use since it doesn’t require resetting the 
port in the Control Panel.)

Completing the 
connection for 
Windows 3.1 
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5 Click OK.

The Printers window appears, with the selected port next to the 
highlighted printer name in the Installed Printers list box.

6 When you are finished, click Close.

■ Setting up IPX (Novell) printing with Windows 3.1
The following procedure describes how to prepare the computer for printing 
using IPX protocols.

Before you begin:

Verify the KX-P8420 has been configured for Novell printing in 
Network Protocol Setup.

For more information about setting up the printer for IPX (Novell) printing, 
see “Setting up IPX (Novell) printing” on page 58.

To set up IPX (Novell) printing:

1 In the Main group of the Program Manager, double-
click the Windows Setup icon.

2 Click Change System Settings from the Options 
menu.

3 Click Novell NetWare (shell version 3.26 and above) 
from the Network menu.
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4 Click OK. When prompted, restart Windows.

5 In the Control Panel window, double-click the Printers 
icon.

6 In the Printers Control Panel window, click Connect to 
connect the KX-P8420 to the appropriate port.

7 Select Network.

If you are printing to a file, select FILE. Printing to a file is useful if 
the printer is not at your site. However, if you select the FILE port, 
you cannot print to a printer until you select a network or printer 
port. If you select Network, the next window depends on the 
NetWare client driver version.

8 If the Network Printer Connections dialog box is 
displayed, select the port in the Printer connections 
box.

9 In the Available queues list box, select the server and 
queue name that correspond to the KX-P8420.

10 Click the Connect button, and then click the Close 
button.

The Connect dialog box is displayed with the network path to the 
KX-P8420.

11 Click OK in the Connect dialog box.

12 Click Close in the Printers dialog box.

13 Click OK.

The Printers window appears again, with the selected port next to 
the highlighted printer name in the Installed Printers list box. You 
are ready to print from the workstation.
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Installing additional software for Windows users
Additional software, including Adobe Type Manager (ATM), a PANTONE 
color reference file, a CMYK reference file, a KX-P8420 ICM profile, is 
included on the KX-P8420 Driver & Utility CD-ROM.

When a Typical installation is performed on Windows 95 or Windows NT 4.0 
using the installer, ATM and fonts are automatically installed to a directory 
on your hard drive called KX-P8420. When a Compact installation is 
performed, only the printer drivers appropriate to your system are installed. 
You can also select which additional files to install during a Custom 
installation procedure, or you can copy the additional files from the 
KX-P8420 Driver & Utility CD-ROM to a directory of your choice as they are 
needed.

NOTE:
• Windows 3.1 users must manually copy the files on the KX-P8420 Driver 

& Utility CD-ROM to their hard drive.

Some files, such as fonts, will need to be moved to specific locations; others 
can be moved to a directory of your choice. 

Regular, bold, italic, and bold italic versions of PostScript Type 1 fonts, as 
well as TrueType fonts are provided in the PS3 Fonts folder on the 
KX-P8420 Driver & Utility CD-ROM. These fonts correspond to the PS3 
fonts installed on your printer. To use these fonts in applications and to 
properly display them on your monitor, you will need to install them on your 
computer. For information on installing fonts, see the following section.

For a complete list of fonts included with the KX-P8420 printer, see 
Appendix A of Drivers and Utilities Reference Guide.

Adobe Type Manager (ATM) is included on the KX-P8420 Driver & Utility 
CD-ROM. This application can be used to transfer Type 1 fonts to the 
printer’s memory or hard disk drive, or to manage fonts on the printer. 
Manual downloading of fonts not already provided on the printer eliminates 
the need for automatic downloading of fonts used by a document, which 
speeds printing. You can also:

• Install the PostScript Type 1 fonts that correspond to those installed on 
your printer

• Print using PostScript fonts on non-PostScript printers

• Improve the screen display of PostScript fonts

PostScript and 
TrueType fonts

ATM (Windows 95 
and Windows 3.1)
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When a Typical installation is performed all the files needed to install Adobe 
ATM for Windows 95 are copied to the KX-P8420 directory. Windows 3.1 
users must manually copy the ATM files on the KX-P8420 Driver & Utility 
CD-ROM to their hard drive. 

See the Help menu of ATM for information on how to use the correct version 
for your system.

NOTE:
• ATM cannot be used to install TrueType fonts, which are also included in 

the PS3 Fonts folder. These fonts can, however, be installed on Windows 
95 and Windows NT 4.0 using the Control Panel >Fonts>File >Install 
New Font command. Windows 3.1 users can install TrueType fonts by 
double-clicking the Control Panel Fonts icon and selecting the fonts to be 
added. For additional information on installing TrueType fonts on Windows 
platforms, see the documentation that came with your system.

CMYK and PANTONE color reference pages are provided on the KX-P8420 
Driver & Utility CD-ROM in the form of downloadable PostScript files. 

■ CMYK Color Reference
The CMYK Color Reference is a PostScript file (Cmyk_ref.ps), which can be 
printed using a PostScript downloader utility, such as Fiery WebDownloader 
or from DOS prompt through parallel port by copy command (ex. copy 
cmyk_ref.ps prn). If the file has not already been installed in the Panasonic 
KX-P8420 directory on your hard disk drive, you can copy it from the 
English>Clrfiles directory on the KX-P8420 Driver & Utility CD-ROM to a 
directory of your choice. 

Each of the 11 pages display swatches in graduated combinations of yellow, 
magenta, and cyan, and smaller patches that include 25%, 50%, and 75% 
black. The process colors are shown in 10% increments. You can specify 
these colors, and colors in between, in any application that allows you to 
define colors as CMYK percentages—and use the pages to see how they 
will be printed on your particular printer.

For more information about color management using the CMYK Color 
Reference, see “Choosing colors in PostScript applications” in Drivers and 
Utilities Reference Guide.

Color reference 
pages
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■ PANTONE Coated Color Reference
The PANTONE Coated Color Reference is a PostScript file (Pantone.ps), 
which can be printed using a PostScript downloader utility, such as Fiery 
WebDownloader or from DOS prompt through parallel port by copy 
command (ex. copy cmyk_ref.ps prn). If the file has not already been 
installed in the Panasonic KX-P8420 directory on your hard disk drive, you 
can copy it from the English>Clrfiles directory on the KX-P8420 Driver & 
Utility CD-ROM to a directory of your choice.

The PANTONE color matching system is a standard color system within the 
graphic arts and prepress industries. It specifies hundreds of spot colors, 
each identified with a unique number. Each PANTONE color is simulated on 
the printer by printing an appropriate combination of process (CMYK) 
colors. The ability to simulate PANTONE colors is a basic form of color 
management. 

You can choose PANTONE colors in any application that allows you to 
define colors as named PANTONE colors—and use the pages to see how 
they will be printed on your particular printer.

For more information about color management using the PANTONE Coated 
Color Reference, see “Choosing colors in PostScript applications” in Drivers 
and Utilities Reference Guide.
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Removing the KX-P8420 software
Follow the instructions below to remove the KX-P8420 software from your 
Windows system:

To remove the KX-P8420 software with Windows 3.1:

1 From the Program Manager, double-click the Main 
icon.

2 Double-click the Control Panel icon.

3 Double-click the Printers icon.

4 Select Panasonic KX-P8420 on LPT1 from Installed 
Printers.

5 Click Remove button.

NOTE:
• Additional files must be removed manually.

To remove the KX-P8420 software with Windows 95:

1 Click the Start button and select 
Programs >Panasonic KX-P8420 >Uninstall 
Panasonic KX-P8420.

2 In the dialog box that appears, click Yes.

3 Follow the instructions on your screen.

NOTE:
• To remove the Panasonic KX-P8420 printer icon from the Printers 

window, click the Panasonic KX-P8420 printer icon and select Delete from 
the File menu.



95

Installing Software for Windows

To remove the KX-P8420 software with Windows NT 4.0:

1 Click the Start button and select 
Programs >Panasonic KX-P8420 >Uninstall 
Panasonic KX-P8420.

2 In the dialog box that appears, click Yes.

3 Follow the instructions on your screen.

NOTE:
• To remove the Panasonic KX-P8420 printer icon from the Printers 

window, click the Panasonic KX-P8420 printer icon and select Delete from 
the File menu.
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This chapter describes installing printer driver software and setting up 
printing on a Macintosh computer. Instructions for setting up additional 
software provided on the KX-P8420 Driver & Utility CD-ROM are included at 
the end of this chapter.

Serial port printing (LocalTalk) from Macintosh computers is not supported 
by the KX-P8420 Color Printer. For instructions on how to connect your 
printer to a network, see page 66. 

General steps for installing Macintosh software
The general steps for installing the KX-P8420 software from the CD and 
setting up printing on a Macintosh computer are:

• Enable Ethernet and AppleTalk from the printer’s front panel

See “Network Port Setup” on page 103 and “Network Protocol Setup” on 
page 105 for details.

• Enable AppleTalk in the Chooser on the Macintosh

• Install the Adobe PostScript printer driver

• Setup the KX-P8420 in the Chooser 

• Copy additional color reference files, sample files, and font files from the 
KX-P8420 Driver & Utility CD-ROM as needed

NOTE:
• Initial Printer Setup, specifically, setting the printer’s IP address and 

subnet mask, as well as its gateway (if they are used), must be performed 
from the printer’s front panel. Additional options may be specified using 
the front panel or Fiery WebSetup.
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Installing Macintosh printing software
To set up the KX-P8420 as a PostScript printer, you must install the 
PostScript printer description file (PPD) that corresponds to your printer and 
the Adobe PostScript printer driver (version 8.5.1 supports PostScript 3) 
provided on the KX-P8420 Driver & Utility CD-ROM. Printer drivers provide 
a way to communicate information on print jobs between your applications 
and the KX-P8420 (and any other PostScript printer connected to your 
computer).

Printer drivers provide your applications with information about your 
KX-P8420, such as the fonts and paper sizes available. Printer description 
files give you access to all printing features of the printer driver and 
applications. When you use the Adobe PS Printer installer, the printer 
description file is installed automatically. 

To install the Adobe PostScript printer driver:

1 Insert the KX-P8420 Driver & Utility CD-ROM in the 
CD-ROM drive and open the English folder, then the 
Adobe PS folder.

2 Double-click the Installer icon.

3 Click Yes in the dialog box that appears.

The Adobe PostScript printer driver and the PPD that corresponds 
to your printer are installed.

4 Click Restart in the dialog box informing you that 
installation is complete.

NOTE:
• For best results any job sent to the KX-P8420 should be sent using the 

Adobe driver and the KX-P8420 PPD. Provide the installer to all users 
who send jobs.

Installing the 
Adobe PostScript 
printer driver
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After you install the printer driver and printer description file, you need to set 
up the KX-P8420 in the Chooser. This section describes how to set up the 
KX-P8420 with the Adobe PostScript printer driver.

To set up the KX-P8420 in the Chooser:

1 In the Chooser, ensure AppleTalk is enabled.

NOTE:
• If necessary you may need to add the AppleTalk zone in which 

your printer is located.

2 Click the AdobePS printer icon in the Chooser.

3 Select the name of the KX-P8420 from the scroll list—
Panasonic KX-P8420_Direct, Panasonic 
KX-P8420_Print, or Panasonic KX-P8420_Hold.

NOTES:
• If the optional hard disk drive is not installed in the printer, only 

Panasonic KX-P8420_Direct appears.

• The name of a printer corresponds to the system name you 
edited when you configured a connection to the printer. See 
“System Setup” on page 110.

4 Click Create or Setup. 

5 Confirm an icon appeared on the left of the printer name 
you selected in step 3.

6 Select the name of the KX-P8420.

7 Click Setup.

8 In the dialog box that appears, click Configure.

If your printer does not have additional devices installed, skip to 
step 12.

9 From the pop-up menus, specify the device options 
installed on your printer. Click OK.

This step must be completed to enable features in the printer driver 
relating to devices installed on the printer.

Setting up the 
KX-P8420 in the 
Chooser
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10 In the dialog box that appears, click Select PPD. 

The Adobe PostScript printer driver automatically selects the 
KX-P8420 printer description file for your printer.

11 Click Select, and then click OK.

12 Close the Chooser.

The Adobe PostScript 8.5.1 driver can convert RGB colors of a file to a 
specified CMYK device target using ColorSync Color Management. The 
KX-P8420 Driver & Utility CD-ROM includes a ColorSync profile for the 
KX-P8420. This profile is optimal for color conversions for the KX-P8420 
printer. 

The KX-P8420 ColorSync profile (KX-P8420 Color Printer.ICC) can be 
found in the ColorSync 2.0 directory. To install this file drag a copy to the 
System Folder/Preferences/ColorSync Profiles folder.

NOTE:
• Printer profiles selected with ColorSync affect ColorSync compliant 

applications only.

Installing the 
KX-P8420 
ColorSync profile
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To use the KX-P8420 ColorSync printer profile:

1 With a document open, select Print from the File menu.

2 Select Color Matching from the pop-up menu under the 
Printer pop-up menu in the Print dialog box.

3 Select ColorSync Color Matching or PostScript Color 
Matching from the Print Color pop-up menu.

4 Select KX-P8420 Color Printer ICC from the Printer 
Profile pop-up menu.

5 Click Save Settings to save the changes to the settings 
in the dialog box.

The changes you made will be the default settings until you make 
additional changes and click Save Settings again.

6 Click OK.

To close the Print dialog box, click Cancel. 
To print a document, click Print.

NOTE:
• PostScript Color Matching must be specified in the Color Matching 

section of the Print dialog box to enable the use of CRDs.
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Installing additional software for Macintosh users
Additional software, including Adobe Type Manager, PostScript screen 
fonts, a PANTONE color reference file and a CMYK reference files are 
included on the KX-P8420 Driver & Utility CD-ROM. Copy these files from 
each folder on the KX-P8420 Driver & Utility CD-ROM to your Macintosh 
hard drive. Note that some files, such as fonts, need to be moved to specific 
locations; others can be moved to a folder of your choice. 

Adobe Type Manager (ATM) is included on the KX-P8420 Driver & Utility 
CD-ROM. This application can be used to transfer Type 1 fonts to the 
printer’s RAM or hard disk, or to manage fonts on the printer. Manual 
downloading of fonts not already provided on the printer eliminates the need 
for automatic downloading of fonts used by a document, which speeds 
printing. You can also:

• Install the PostScript Type 1 fonts that correspond to those installed on 
your printer

• Print using PostScript fonts on non-PostScript printers

• Improve the screen display of PostScript fonts

In addition to PostScript Type 1 fonts, TrueType fonts are included in the 
PS3 Fonts folder on the KX-P8420 Driver & Utility CD-ROM. 

ATM cannot be used to install TrueType fonts. These fonts can, however, be 
installed by dragging a copy of each from the PS3 Fonts folder on the 
KX-P8420 Driver & Utility CD-ROM to your System folder.

For a complete list of fonts included with the KX-P8420, see Appendix A of 
the Drivers and Utilities Reference Guide.

Adobe Type 
Manager

PostScript and 
TrueType fonts
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 Setup from the Front Panel and WebSetup

This chapter describes how to configure the printer’s Setup options. The 
settings you specify in Setup determine user access to the printer, printing 
defaults applied to jobs, and general system settings. Some Setup options 
are specified during an initial Setup from the printer’s front panel; others 
must be set later from Fiery WebSetup. 

Initial Setup from the front panel
Initial Setup for network printing must be performed using the front panel. 
After the initial Setup is complete, you must finish configuring Setup options 
using Fiery WebSetup (see page 108). Some options set from the front 
panel can also be modified using Fiery WebSetup. 

The general steps for performing Setup from the front panel are:

• Specify parallel port settings (page 103).

• Specify network port settings (page 103).

• Specify network protocol settings (page 105).

Before you change any Setup options, it’s a good idea to print the current 
configuration settings, in case you need to restore these settings later. For 
information on printing a configuration page, see “Printing pages from the 
front panel” on page 44.

Use the following procedure to access the Parallel Port Setup, Network Port 
Setup, and Network Protocol Setup menus from the front panel.

To access Setup menus from the front panel:

1 Turn on the printer.

Wait until Ready or Ready(Sleep) is displayed.

2 Press the Menu/Exit button.

3 To advance through the options, press the Continue/
Forward button; to return to previous options, press the 
Cancel/Left button.

4 To select an option, press the Enter button.

Repeat steps 3 and 4 to continue accessing other options.

5 To exit the Setup menus at any time, press the Menu/
Exit button.
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If set to On, the printer automatically turns to energy saving mode when 
there are no print jobs received or access to the front panel for more than 
30 minutes. This mode can reduce the total power consumption of the 
printer to less than 35 watts. Full power mode is restored when the printer 
receives a job or when you press the Menu button and print a page at the 
printer.

In addition to receiving print jobs over Ethernet or Token Ring, the printer 
can receive print jobs from a computer through its high-speed parallel port. 
If no network card is installed, the printer is connected to a computer via the 
parallel port.

Parallel Port Setup

To advance to the next screen, press the Enter button.

Enable Parallel?
Yes/No [Yes*]

Press the Enter button and select Yes to enable printing through the parallel 
port. Press the Enter button.

Time out
5 to 100 [15*]

This screen appears only if Enable Parallel is set to Yes. Use this option to 
specify how long the printer waits without receiving data from the parallel 
port before deciding the current job is complete. Press the Enter button.

Data Mode
Binary/ASCII [ASCII*]

(*=Default setting)

The Network Port Setup menus allow you to specify and set up a printer 
port type, including: Ethernet (if optional Ethernet card is installed), Token 
Ring (if optional Token Ring card is installed), or parallel port. 

NOTES:
• Ethernet and Token Ring options appear only if an optional Ethernet or 

Token Ring card is installed.

• The settings do not become effective until the printer reboots or the 
printer is turned off and on. So if you just change the settings in Network 
Port Setup and do not change the settings in Network Protocol Setup, you 
have to turn off and on the printer.

Before you set up the printer for a Novell IPX network, be sure you have set 
up the Novell servers as described in “Setting up IPX (Novell) printing” on 
page 58.

ENERGY STAR®

Parallel Port Setup

Network Port 
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Network Port Setup

To advance to the next screen, press the Enter button. 

A) When the Ethernet card is installed in the printer:

Ethernet Setup 

Press the Enter button to enable advance to the Ethernet Speed screen. 
Press the Enter button.

Ethernet Speed
Auto-Detect/10Mbps/100Mbps [Auto-Detect*]

Select the speed at which data can be transferred over the Ethernet 
network or select Auto-Detect to automatically detect the speed at which 
data can be transferred over the Ethernet network. In some cases, Auto-
Detect may not correctly detect. If it happens, specify the correct speed in 
this menu or from WebSetup.

B) When the Token Ring card is installed in the printer:

Token Ring Setup

Press the Enter button to view Token Ring network options.

NOTE:
• Token Ring options appear only if an optional Token Ring card is installed.

Token Ring Speed 
Auto-Detect/4 Mbps/16 Mbps [Auto-Detect*]

Select a speed at which data can be transferred over the Token Ring 
network, or select Auto-Detect to automatically detect the speed at which 
data can be transferred over the Token Ring network.

Max. Frame Size
632/1130/2154/4202 [4202*]

Select a frame size for Token Ring communication.

Source Routing
Yes/No [No*]

Select YES to allow the packet to travel to its destination through routers on 
the network. The packet’s source, specified using the routing options listed 
below, dictate the route that the packet will take. Select No for transparent 
(no source) routing.

NOTE:
• Req. All Route and Resp. All Route are displayed only when YES is 

selected in Source Routing.

(*=Default setting)



105

Setup from the Front Panel and WebSetup

Req. All Route
Yes/No [No*]

If source routing is enabled, select Yes to allow all routers on the network to 
broadcast the presence of the printer to clients, enabling packets from 
clients on the network to travel to the printer by any route.

Resp. All Route
Yes/No [No*]

If source routing is enabled, and Req. All Route is set to No, select Yes to 
allow all routers on the network to broadcast the presence of clients to the 
printer, enabling packets from clients on the network to travel to the printer 
by any route.

(*=Default setting)

Network protocol setup screens are used to specify and setup TCP/IP 
Ethernet, TCP/IP Token Ring, AppleTalk and IPX (Novell) network protocols.

NOTE:
• When exiting Setup menus, the printer will automatically restart if 

changes have been made to Network Protocol settings. 

Network Protocol Setup

To advance to the next screen, press the Enter button. Select TCP/IP Setup, 
AppleTalk Setup, or IPX/SPX Setup, depending on your network 
connections.

A) When you select TCP/IP Setup:

TCP/IP Setup 

Press the Enter button to view TCP/IP options.

Enable TCP/IP?
Yes/No [No*]

Select Yes if you have a TCP/IP network connected to the printer over 
Ethernet cabling.

Ethernet IP Address or Token Ring IP Address
[127.000.000.001*]

Use this option to assign the printer an Ethernet or Token Ring IP address. 
Press the Continue/Forward button to increment a value. Press the Cancel/
Left button to accept a value and move to the next number to be entered. 
Numbers are entered from right to left. When all values have been entered, 
press the Enter button to accept your selection.

(*=Default setting)

Network 
Protocol Setup
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Ethernet Subnet Mask or Token Ring IP Address
[255.255.255.0*]

Use this option to specify the subnet mask for printing with TCP/IP over 
Ethernet or Token Ring. Press the Continue/Forward button to increment a 
value. Press the Cancel/Left button to accept a value and move to the next 
number to be entered. Numbers are entered from right to left. When all 
values have been entered, press the Enter button to accept your selection.

Use the arrow buttons to select numbers in the address. Press the Enter 
button to accept your selection. 

Gateway Address
[127.0.0.1*]

Use this option to specify the gateway address for printing with TCP/IP. By 
default, no gateway address is set. If your TCP/IP network has a gateway 
and you plan to print using TCP/IP, you must enter the gateway address. 

(*=Default setting)

B) When you select AppleTalk Setup:

AppleTalk Setup

To advance to the next screen, press the Enter button.

Enable AppleTalk?
Yes/No [No*]

Select YES if you have an AppleTalk network connected to the printer. Note 
that you can enable AppleTalk, TCP/IP, and IPX (Novell) communication 
simultaneously.

NOTE:
• The following option is displayed only if AppleTalk is enabled.

AppleTalk Zone

Select the AppleTalk zone in which you want the printer to appear. If you do 
not select a zone, the printer is assigned to the default AppleTalk zone. 

(*=Default setting)
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C) When you select IPX/SPX Setup:

IPX/SPX Setup

To advance to the next screen, press the Enter button.

Enable IPX/SPX?
Yes/No [No*]

Select Yes if you have an IPX (Novell) network connected to the printer. 
Note that you can enable AppleTalk, TCP/IP, and IPX (Novell) 
communication simultaneously. 

(*=Default setting)

The panel language setup menus are used to select a language for the front 
panel.

Language

Press the Enter button to view language options.

Menu Mode
English/Français/Deutsch/Español/Italiano [English*]

Select a language for the printer’s front panel and Configuration page.

(*=Default setting)

This screen appears only if an optional hard disk drive is installed. Resetting 
the queues clears all jobs from the Hold and Print queues, all Check and 
Print jobs, and the Job Log. It does not affect print option settings specified 
in Setup from the front panel or from Fiery WebSetup.

Reset Queues
Yes/No [No*]

(*=Default setting)

This screen appears only if an optional hard disk drive is installed. If you 
select Yes, all data on the hard disk drive is deleted, including jobs in the 
Hold and Print queues, Check and Print jobs, and the Job Log.

Format?
Yes/No [No*]

(*=Default setting)

Language Setup

Reset Queues 

Hard Disk 
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Completing setup from Fiery WebSetup
After you have performed an initial Setup from the printer’s front panel (see 
page 102), you must complete the process of configuring Setup options 
using Fiery WebSetup, one of the Fiery WebTools. You can also use 
Fiery WebSetup to remotely view and modify Setup options later. 

Before you can access the Fiery WebTools, you must complete the 
following:

• Initial Setup, specifically, setting the printer’s IP address, and subnet mask 
as well as its gateway from the front panel; see page 102.

• The procedures described in “Setting up Fiery WebTools” on page 67.

To use the Fiery WebTools via the Internet or your site’s intranet, you need 
an Internet browser and the IP address or DNS name of the KX-P8420.

To access Fiery WebSetup:

1 Start up your Internet browser application. 

2 Enter the IP address or the DNS name of the KX-P8420 
in the URL line of your browser.

Get the IP address or DNS name from your network administrator. 

The KX-P8420 home page appears. The individual Fiery WebTools 
are listed on the left. To display information about a particular tool, 
click the question mark next to its name. 

Accessing 
Fiery WebSetup
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3 Click WebSetup.

If a password has been set on the printer, you are prompted to 
enter it before you can access Fiery WebSetup.

The options that you can specify from Fiery WebSetup are grouped into 
three categories: System Setup, Network Setup, and Printer Setup. These 
are described in the following sections.

If you change a Setup option, the Cancel and Save buttons flash when you 
click to select another Setup category. 

• Click Save to save a change made to a setting.

• Click Cancel to cancel a change.

NOTE:
• You must click either Save or Cancel before you can proceed to another 

Setup category or exit Fiery WebSetup.

When you have finished specifying settings from Fiery WebSetup, click 
Save to save your settings, and then close the Fiery WebSetup window.
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In System Setup, you specify settings from two tabs: the System Setup tab 
and the Password tab.

To set System Setup options:

Click the System Setup button. 

■ System Setup tab
The options that you can set from the System Setup tab are described 
below.

System Name—The default name of the printer appears in this text field. 
Edit the default name here. This is the name you should enter when you 
configure a connection to the printer over AppleTalk.

Print Start Page—The KX-P8420 does not have Start Page. So please 
ignore this setting.

Enable Printed Queue—If your printer has a hard disk drive installed, 
select this option to create a storage location on the hard disk for the most 
recent print jobs. Users with Administrator privileges can use the 
WebSpooler to reprint jobs in the printed queue without sending those jobs 
to the printer again. 

Jobs Saved in Printed Queue—Specify the number of jobs (from 1-99) to 
be saved in the Printed Queue.

System Setup
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■ Password tab
From the Password tab you can set an Administrator password or change 
the existing one. Once an Administrator password has been set, users will 
be prompted for this password when they attempt to access 
Fiery WebSetup or Fiery WebSpooler.

To set or change the Administrator password:

Click the Password tab. 

Enter New Password—To set a new password, enter a password in the 
Enter New Password text field. 

Verify Password—To verify a new password, enter the same password in 
the Verify New Password text field as you have entered in the Enter New 
Password text field.

NOTE:
• By default no password is set on the KX-P8420. It is recommended that a 

password be set to protect the printer from accidental or incorrect 
changes to printer Setup settings.
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In Network Setup, you specify settings from four tabs: Port Setup, Protocol 
Setup, PServer Setup, and Service Setup.

To set Network Setup options:

Click the Network Setup button. 

The Port Setup tab is the first tab displayed in Network Setup. You can also 
access Protocol Setup, PServer Setup, and Service Setup tabs from this 
window. After setting all the options in the Port Setup tab, click the next tab 
and continue to specify settings until you have made settings for all relevant 
options in the Network Setup category.

■ Port Setup tab
The options that you can set from the Port Setup tab are described below. 

Enable Ethernet—Enable this option if the KX-P8420 is to be connected to 
an Ethernet network.

Transmission Speed—Select Auto Detect if your network environment is 
mixed, or select the speed (10 Mbps or 100 Mbps) of the network to which 
the KX-P8420 is attached.

Network Setup
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Enable Parallel Port—Enable this option if you want to print through the 
parallel port. You can connect a single Windows computer to the parallel 
port and print directly to the KX-P8420.

NOTE:
• Enabling the parallel port does not conflict with Ethernet or Token Ring 

communication with the KX-P8420. 

Ignore EOF Character—Available only if Enable Parallel Port is enabled, 
this option specifies that the KX-P8420 should ignore end-of-file (EOF) 
messages. 

Enabling this option is required to print PostScript files in binary format (not 
ASCII); under normal circumstances, this option should not be enabled. 
When this option is enabled, the KX-P8420 uses the parallel port timeout 
value to determine when the end of the file has been reached.

Parallel Port Timeout (seconds)—Available only if Enable Parallel Port is 
enabled, this option’s setting determines how long the KX-P8420 waits 
without receiving data from the parallel port before deciding that the current 
job is complete. Until the timeout, the KX-P8420 cannot receive new jobs 
through the parallel port, but it can continue to receive network print jobs.

Enable Token Ring—Enable this option if the KX-P8420 is to be 
connected to a Token Ring network.

Maximum Frame Size—Select the maximum frame size recommended by 
the network administrator at your site. If you are uncertain of the setting to 
use, select the default value (4202 bytes).

Enable Source Routing—Enable this option if your network supports 
source routing.

Request All Routes—This option is active only if you enabled Source 
Routing. Enable this option if you want the Request packet to travel to its 
destination by all routes.

Respond All Routes—This option is active only if you did not enable the 
previous option (Request All Routes). Enable this option if you want the 
Response packet to return by all routes to the originating computer.
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■ Protocol Setup tab
The options that you can set from the Protocol Setup tab are described 
below. 

The KX-P8420 can accept jobs via TCP/IP (over either Ethernet or Token 
Ring), AppleTalk, and IPX/SPX simultaneously. To configure the KX-P8420, 
choose each protocol and enter the settings for that protocol.

Enable Ethernet or, if you have enabled and installed the Token Ring option, 
enable Token Ring. If your network uses a gateway, enter the gateway 
address.

Enable on Ethernet—Enable this option if you have a TCP/IP network 
connected to the KX-P8420 over Ethernet cabling.

You must enable TCP/IP for Ethernet to use the Fiery WebTools over 
Ethernet.

IP Address—Enter the KX-P8420 IP address for Ethernet. The KX-P8420 
is shipped with the IP address set to the loopback address (127.0.0.1), 
which is an internal address used for network checking. If you plan to print 
with TCP/IP, you must first assign the KX-P8420 a unique network IP 
address. For information about setting up printing with TCP/IP, see “Setting 
up TCP/IP printing” on page 50.
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Subnet Mask— If you need to set the subnet mask, enter one of the 
following values:

• 255.0.0.0 if the IP address starts with a number less than 128

• 255.255.0.0 if the IP address starts with a number from 128 through 191

• 255.255.255.0 if the IP address starts with a number greater than 191

Be sure to confirm the subnet mask setting with your network administrator 
before proceeding. In some cases the required setting may be different from 
those listed.

Enable on Token Ring—Enable this option if you have a TCP/IP network 
connected to the KX-P8420 over Token Ring. If you use Token Ring, 
enabling TCP/IP for Token Ring is required for enabling the Fiery WebTools.

IP Address—Enter the KX-P8420 IP address for Token Ring. The 
KX-P8420 is shipped with the IP address set to the loopback address, 
(127.0.0.1) which is an internal address used for network checking. If you 
plan to print with TCP/IP, you must first assign the KX-P8420 a unique 
network IP address. For information about setting up printing with TCP/IP, 
see “Setting up TCP/IP printing” on page 50.

Subnet Mask—If you need to set the subnet mask, enter one of the 
following values:

• 255.0.0.0 if the IP address starts with a number less than 128

• 255.255.0.0 if the IP address starts with a number from 128 through 191

• 255.255.255.0 if the IP address starts with a number greater than 191

Be sure to confirm the subnet mask setting with your network administrator 
before proceeding. In some cases the required setting may be different from 
those listed.

Gateway—If your TCP/IP network has a gateway, and users outside the 
gateway plan to print to the KX-P8420 using TCP/IP, enter the gateway 
address here. By default, the loopback address, 127.0.0.1, is set. Obtain the 
correct gateway address from your network administrator.

Enable AppleTalk—Enable this option if you have an AppleTalk network 
connected to the KX-P8420. This setting enables the KX-P8420 to 
communicate over AppleTalk networks.
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Select Zone— The KX-P8420 searches the network for AppleTalk zones in 
your network segment. Scroll through the list to select the AppleTalk zone in 
which you want the KX-P8420 to appear. If your segment has only one 
zone, the KX-P8420 is assigned to that zone automatically.

If no AppleTalk zone can be found, your network may have no defined 
zones, or else the network cable has not been connected (see page 46). 
Choose OK.

Select Frames—Click the Select Frames button to specify IPX frames 
used with NetWare. See your network administrator to verify which frame 
type to choose.

In the IPX Frames dialog box, select frames and use the Add and Remove 
buttons to specify the selected frames.

■ PServer Setup tab
IPX (Novell NetWare) options are set in the PServer Setup tab.

You can modify both NetWare 3.x (Bindery) and NetWare 4.x (NDS) 
configurations from Fiery WebSetup. Turn on the Enable NDS option if your 
network uses NetWare 4.x in native mode. Click Bindery Setup if your 
network uses NetWare 3.x or uses NetWare 4.x in bindery emulation mode. 
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NOTE:
• If your network uses both NDS and Bindery, set up NDS first. Setting up 

NDS after Bindery will overwrite Bindery Setup. If your network uses both 
NDS and Bindery, including using NetWare 4.x servers in bindery 
emulation, the KX-P8420 cannot service NDS and bindery emulation 
servers on the same NDS tree.

PServer Setup (NetWare Services)

The Enable PServer mode option must be turned on if you have a Novell 
server connected. You can change the PServer Poll Interval and modify 
either Bindery Setup or NDS Configuration.

NOTE:
• To set Enable PServer mode to be active, first you must select one more 

than Frame Type. See “Select Frames” on page 116.

A) PServer Setup (NDS Configuration)

In initial setup, the KX-P8420 was connected to the network and an NDS 
directory tree, with a Printer, a Print Server, and one or more Print Queue 
objects for KX-P8420 jobs was configured (see page 63). You can make any 
changes to that setup through WebSetup. To modify NDS Setup you may 
need permission to browse the NDS tree. If access to the Print Server is 
restricted, you’ll need a login password.

Note that the terms NetWare server, Novell server, and IPX server are in 
common use and are used here interchangeably to mean the server on an 
IPX network running Novell NetWare networking software.

To set up the NDS configuration:

1 Check on Enable NDS check box.

NDS has already been enabled. Uncheck this box only to remove 
NDS support.

2 Click Change Trees to open the Add NDS Tree window.

You can have only one NDS tree, so the following process is 
required to change trees.

3 Select the current NDS tree and click Remove.
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4 Select the new NDS tree and click Add.

Your new NDS tree selection automatically overwrites any previous 
tree selection. If you change the NDS tree selection and there are 
also current Bindery settings, you are alerted that they will be 
deleted. If you continue with NDS Setup, you can replace Bindery 
settings afterwards. To exit NDS Setup, choose Cancel.

5 Click OK.

The Select login user window appears.

6 Select the User Login object from the display in the 
Select Login User window. 

7 Enter a password if necessary.

8 Click Next.
The Select Print Server window appears.

9 Select the print server from the display in the Select 
Print Server window.

10 Enter a password if necessary.

11 Click OK.

The Select Print Queue root window appears.

12 Select the print queue root from the display in the Select 
Print Queue Root window.

13 Enter a password if necessary.

14 Click Finish.
The NDS Configuration window reappears, showing the new settings. 

15 Click OK.

You return to WebSetup window.

16 Click Save.
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B) PServer Setup (Bindery Setup)

Use Bindery Setup if you have already configured one or more bindery 
servers (file servers running NetWare 3.x or NetWare 4.x in bindery 
emulation) with a Print Server and a Print Queue for KX-P8420 jobs (see 
page 63). Before entering bindery settings, be sure the KX-P8420 is 
connected to the network and the NetWare file server is running. You’ll need 
a login name, and, if access to the file server or print server is restricted, 
you’ll need a login password.

NOTE:
• The terms NetWare server, Novell server, and IPX file server are in 

common use and are used here interchangeably to mean the server on 
an IPX network running Novell NetWare networking software.

Because you can set up more than one Novell server to handle KX-P8420 
print jobs, Bindery Setup allows you to add or delete new file server 
connections and view the connections you have selected.
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To set up the Bindary Setup:

1 Click the Bindery Setup button to display the Add 
Connections window.

The Novell Setup window appears.

2 Click the server you want to add.

3 Click Add.

The Add Server window appears.

4 Enter your user name and password.

5 Click Next.
The Add Server window shows a list of print servers you can add.

6 Select a print server from the list on the left.

7 Enter a password if a password is required.

8 Click Finish.

You return to the main Novell Setup dialog box.
The print server you selected in the step 6 appears.

9 Click OK.

You return to WebSetup window.

10 Click Save.
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■ Service Setup tab
The Service Setup tab is used to set Windows Printing Service options. 
Windows Printing Service enables the Microsoft SMB protocol, which 
supports peer-to-peer printing, also known as Windows (WINS) or SMB 
printing. 

Enable Windows Printing Service— Enable this option to enable SMB 
(Server Message Block), the file and printer sharing protocol built into 
Windows. Enabling SMB allows the KX-P8420 to be listed on the network 
so that Windows clients can print to a particular print connection (Hold, 
Print, or Direct) on the KX-P8420 without any other networking software. 
For information on how to set up a Windows client for Windows printing, see 
pages 70 and 73.

Windows (SMB) printing runs over TCP/IP, so TCP/IP must be configured 
on all the KX-P8420 and on workstations that use Windows printing.

Server Name—The server name is the name that will appear on the 
network.

NOTE:
• Lowercase characters are not allowed to enter.

Comment—Server comments (optional) can contain information about the 
printer.
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Domain Workgroup—Enter the workgroup or domain you want the 
KX-P8420 to appear in.

NOTE:
• Lowercase characters are not allowed to enter.

Use WINS Server—Select to use a WINS name server. Broadcasts from 
SMB devices cannot be routed beyond their original network segment 
without a WINS name server. Setting up the WINS name server is outside 
the scope of this manual. To find out if a name server is available, contact 
your network administrator.

IP Address—Enter the IP address of the WINS Server.

NOTE:
• The Enable LPD Printing Service and Enable Web Services options are 

not in effect for the KX-P8420.

In Printer Setup, you specify PostScript printing option settings from the 
PS Setup tab.

To set PostScript printing options:

Click the Printer Setup Button.

Printer Setup
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■ PS Setup tab
The options that you can set from the PS Setup tab are described below.

Print to PS Error—Specify whether the KX-P8420 should print the 
available portion of a print job when it encounters a PostScript error. Select 
Yes to print an extra page with PostScript error messages. Select No to 
cancel the job entirely whenever a PostScript error is encountered.

NOTE:
• In some cases, the extra page may not be printed even when No is 

selected.

Cover Page—Specify whether the KX-P8420 prints a cover (job summary) 
page at the end of each print job. If you select Yes, each print job is followed 
by a page containing the name of the user who sent the job, the document 
name, the server name, the time the job was printed, the number of pages 
printed, and the status of the job. If a PostScript error occurs, and the Print 
to PS Error option is set to Yes, an error message takes the place of the job 
status.

NOTE:
• Some information may not be printed depending on the operating system 

on which a job is printed.

When you have finished specifying settings from Fiery WebSetup, click 
Save, and then close the Fiery WebSetup window by clicking the X in the 
top right corner of the window. The Reboot window appears, and you are 
asked whether you reboot the computer or not. Select Yes, and the setting 
becomes active.

Saving your 
settings and 
exiting 
Fiery WebSetup
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Color Calibration

Output from color print devices is subject to changes in temperature and 
humidity, and is prone to drift over time, with a resulting loss in color 
predictability. Where color accuracy and consistency are crucial, regular 
calibration of the KX-P8420 and print device is necessary. The color 
production of your KX-P8420 color printer can be adjusted using three 
different methods: Bias Adjustment, VisualCal, and ColorWise Color 
Adjustment. 

There are 3 types of Color Calibration method.

• Bias Adjustment:
It is for adjusting the overall color density. If you feel color output has 
become too dark or too bright, please execute Bias Adjustment first.

• Visual Calibration:
This is to take the most advantage of the range of color density and to 
adjust gray balance. Please execute Visual Calibration after you execute 
Bias Adjustment or if you feel the gray color in image does not look as a 
pure gray.

• Color Adjustment:
By this menu you can adjust the overall brightness of color output and 
saturation of each color. If you wish to adjust color output to your 
preference, execute this after executing Bias Adjustment and Visual 
Calibration.

The following sections describe how to use these methods to adjust the 
color production of you printer.
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Bias adjustment 
The printer’s bias adjustment feature provides basic control over the 
printer’s color production. The bias adjustment screens, accessible via the 
front panel, allow you to override the printer’s current toner density and 
brightness settings.

Using the bias adjustment and calibration offset controls, you can increase 
or decrease the density of cyan, magenta, yellow or black, and increase or 
decrease the overall brightness of all toner colors.

To perform the Bias Adjustment, do the following:

1. Print a Color calibration page to confirm the current bias adjustment. 
(See below.)

2. Compare the color calibration page with the provided color calibration 
card. (See page 127.)

3. Perform bias adjustment. (See page 128.)

NOTE:
• Visual Calibration and Color Adjustment settings may affect the settings 

of Bias Adjustment.

— Please restore the settings in Color Adjustment to the default values 
(all 0) before using Bias Adjustment.

— Please reset the Visual Calibration before Bias Adjustment.

To print a color calibration page:

1 Press the Menu/Exit button on the printer panel.

Test Page is displayed in the LCD panel.

2 Press the Continue/Forward button.

Bias Adjustment is displayed in the LCD panel.

3 Press the Enter button.

Calibration Offset is displayed in the LCD panel.

4 Press the Continue/Forward button 5 times.

Calibration Test Print is displayed in the LCD panel.

5 Press the Enter button.

A Color Calibration Page will be printed. (See next page.)
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The current density setting for each color is indicated by the line 
enclosure on the Color Calibration Page.

Color Calibration Page:

Current color density settings
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To compare current setting with the color density samples:

1 Compare the current color density settings on the Color 
Calibration Page with the color density samples on the 
Color Calibration Card to see if they match.

Place the Color Calibration Page on at least 2 sheets of clean white 
paper in a well-lighted area.

• If they match, then you do not need to adjust the color density 
and you may proceed with any operation you wish to perform.

• If they do not match, proceed to “To perform bias adjustment:” on 
page 128.

2 Determine which block on the Color Calibration Page 
most closely matches the density of the cyan sample on 
the Color Calibration Card.

Repeat step 2 for each color.

Color calibration card

Color calibration page
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To perform bias adjustment:

1a If you wish to adjust the density for all colors 
simultaneously, perform the following, then go to step 2.

1)Repeat instructions steps 1 through 3 in “To print a 
color calibration page:” on page 125.

Calibration Offset is displayed in the LCD panel.

2)Press the Enter button. 

0* (–5 to 5) is displayed in the LCD panel.

3)Press the Continue/Forward or Cancel/Left button 
to darken/lighten all the colors.

Press the Continue/Forward or Cancel/Left button twice selects 
the next or previous level settings.

For example:

• If you wish to make the density setting darker by 2 levels:

—Press the Continue/Forward button 4 times.

• If you wish to make the density setting lighter by 1 level:
—Press the Cancel/Left button 2 times.

4)Press the Enter button.

CYAN is displayed in the LCD panel.

5)Press the Continue/Forward button 4 times.

Calibration Test Print is displayed in the LCD panel.

1b If you wish to adjust the density for each color 
independently, perform the following, then go to step 2.

1)Repeat instructions steps 1 through 3 in “To print a 
color calibration page”.

2)Press the Continue/Forward button. 

CYAN is displayed in the LCD panel.

3)Press the Enter button.

0* (–10 to 10) is displayed in the LCD panel.

4)Press the Continue/Forward or Cancel/Left button 
to darken/lighten the cyan color.

Pressing the Continue/Forward or Cancel/Left button twice 
selects the next or previous level setting.

For example:

• If you wish to make the density setting darker by 4 levels:
—Press the Continue/Forward button 8 times.
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• If you wish to make the density setting lighter by 2 levels:
—Press the Cancel/Left button 4 times.

5)Press the Enter button.

MAGENTA is displayed in the LCD panel.

6)Repeat instructions 3) through 5) for each color 
(MAGENTA, YELLOW, BLACK).

• To skip a color, press the Continue/Forward button. 

• To return to a previous color, press the Cancel/Left button.

• Before going to step 2, make sure the following is displayed. 
Calibration Test Print is displayed in the LCD panel.

2 Press the Enter button to reprint the Color Calibration 
Page.

• The line enclosure reflects the changes made to the settings.

• If you are not satisfied with the current color density settings, 
repeat the steps above.

NOTES:
• Changes made using Bias Adjustment are retained until the printer is 

recalibrated.

• The color density setting affects the average life of toner.

• Save the Color Calibration Card for future calibrations.
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VisualCal, 30% match calibration
VisualCalTM is a calibration method that allows you to recalibrate your 
printer to an ideal color output standard defined by the printer’s 
manufacturer.

The calibration calculations performed by the controller software are based 
on a series of values entered through the front panel. The values used in 
the calculations are determined by evaluating toner densities and color 
combinations produced on two specially designed calibration pages printed 
from the front panel.

The first VisualCal page, Limits, 30% Match, provides the basis for 
calculating the most acceptable luminosity (brightness) of the toners. This 
page contains rows of CMYK dots in a graduated range of toner densities.

The variables needed to recalculate the density of the colored toners are 
determined by identifying the leftmost dots that can be fully distinguished 
against their fields in each row, and sequentially entering their 
corresponding numeric values via the front panel. The variable needed to 
recalculate the luminosity of the toners is determined in a slightly different 
way- the user is required to identify the black dot which best matches a 30% 
dot gain field. When all values have been entered, the printer’s toner 
density and luminosity settings are recalculated.

The second VisualCal page, Gray Balance, provides the basis for 
calculating a neutral gray balance, that is, a CMY gray that as closely as 
possible matches a pure K (BlacK) gray produced by the printer’s engine. 
This page consists of rows of CMY gray patches on a field of gray produced 
solely from black. The variables needed to calculate the printer’s most 
neutral gray balance are determined by identifying the CMY patch that best 
matches this field, and entering its row and column location on the front 
panel. When the values have been entered, the printer’s gray balance is 
recalculated.

NOTES:
• Cannot print the Gray Balance page before the Limits calculations are 

made, because the gray field on which the CMY patches appear (on the 
Limits page) reflect the new density and luminosity calibration settings.

• Visual Color Calibration/Color Adjustment

1. You cannot execute visual color calibration or color adjustment menu if 
the printer shows error or warning messages. If you encounter this, 
please troubleshoot them in advance.

2. If you enter the incorrect value intentionally in visual color calibration, it 
might cause the worst output. If it happens, try to do the procedure 
again as precise as possible.
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The following procedure outlines how to calibrate the printer using 
VisualCal.

To perform VisualCal calibration:

1 From Ready or Ready(Sleep), press the Menu button 
and then press the Continue/Forward button 
repeatedly to advance to the Visual Calibration menu. 
Press the Enter button.

2 When the screen displays Endpoint Page on the first 
line and Print on the second line, press the Enter 
button. 

Wait for the VisualCal Limits and 30% Match page to be printed. 
You will use this page to reset the printer’s toner density and 
luminosity settings.

3 When the screen displays Black Low, begin the 
process of specifying Low and High values for each of 
the four toner colors, and a value for the 30% Match. 

Follow the instructions provided on the Limits and 30% Match page. 
Note that the term Low displayed on the front panel corresponds to 
the term Start on the Limits and 30% Match page; for example, to 
enter the Black Low value, check the Black Start row on the Limits 
and 30% Match page. 

Use the Cancel/Left button or the Continue/Forward button to 
access lower or higher values (numbers). Accept a value by 
pressing the Enter button.

NOTE:
• Zero (0) and 9 are unacceptable values for color calibration. If 

any of the entered values for any colors are 0 or 9, the Limits and 
30% Match page is reprinted automatically. Reenter values for all 
color rows starting with Black Start (Black Low).

When you have finished entering all values, the Gray Balance 
menu appears. 

Calibrating the 
printer using 
VisualCal
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4 To print the Gray Balance page, press the Enter 
button. 

Best Patch (Row) appears. 

To reset the printer’s gray balance, follow the instructions on the 
Gray Balance page.

NOTE:
• You can skip printing Gray Balance page by selecting Skip.

5 Select the row number of the most acceptable patch. 
Use the Cancel/Left button or the Continue/Forward 
button to select a value (+4 to –4). Accept a value by 
pressing the Enter button.

Best Patch (Col) appears.

6 Select the column number of the most acceptable patch. 
Use the Cancel/Left button or the Continue/Forward 
button to select the column. Accept a value by pressing 
the Enter button.

When you have finished entering all values, the Color Test menu 
appears.

7 To print a Color Test that uses the original values and a 
Color Test that uses the new values, press the Enter 
button. 

NOTE:
• You can skip printing Color Test page by selecting Skip.

Before applying the calibration changes compare the Color Test 
that uses the original calibration values against the Color Test that 
uses the new values. If you are satisfied with the printer’s 
calibration based on the new values, select Yes from the Apply 
Changes screen that appears, and press the Enter button to 
recalibrate the printer based on the previously entered values. If 
you are not satisfied with the printer’s calibration based on the new 
values, select No from the Apply Changes screen that appears. Or 
if you want to reset the calibration, select Default.
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Color adjustment 
The printer’s color adjustment feature provides additional creative control 
over printer’s color production. The color adjustment screens, accessible 
via the front panel, allow you to override the printer’s current toner density 
and brightness settings.

Using the color adjustment controls, you can also increase or decrease the 
brightness of an image, or you can increase or decrease the density of each 
the following colors: red, yellow, green, cyan, blue or magenta.

For example, you may choose to make the blues in an image look surreal 
by increasing the density of the blue and the cyan in the image, and 
increasing the brightness setting. 

NOTE:
• You can adjust only one color at a time.

To perform color adjustment:

1 From Ready or Ready(Sleep), press the Menu button 
and then press the Continue/Forward button 
repeatedly to advance to the Color Adjustment screen. 
Press the Enter button.

The Adjust Brightness menu appears.

2 Use the Cancel/Left button or the Continue/Forward 
button to select a value*1 (+5 to –5) that will increase or 
decrease in the overall brightness of printed documents. 
Press the Enter button.

The Adjust Color menu appears.

*1 Negative values are darker, positive values are lighter. 

3 Use the Cancel/Left button or the Continue/Forward 
buttons to select a color to be adjusted, and press the 
Enter button.

4 Use the Cancel/Left button or the Continue/Forward 
button to select a value*2 (+5 to –5) that will increase or 
decrease in the density of the color to be adjusted. 
Press the Enter button.

The Color Test menu appears.

*2 Negative values are lighter, positive values are darker. 
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5 To print a Color Test that uses the new values, press 
the Enter button.

Color Test pages that uses the new values are printed.

6 To apply the new color and brightness values use the 
Cancel/Left button or the Continue/Forward button to 
select Yes. Press the Enter button.

NOTE:
• Changes made using Color Adjustment are retained until the printer is 

recalibrated. Or reset the adjusted colors to the last calibration made 
using the Reset All to 0 option in the Adjust Color screen; or recalibrate 
the printer using VisualCal. 
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Cleaning
Periodic cleaning of the printer is recommended, depending on the 
environment in which the printer is used. You should clean the printer:

• At least once a month

• When the printer experiences frequent media jams

• When print quality starts to deteriorate

To clean the outside of the printer:

1 Turn the power OFF.

2 Clean all the covers with a soft cloth, using any mild 
commercial cleaner.

CAUTION:
• Do not use benzine, thinner, aerosol cleaners, or any abrasive powder.

NOTE:
• When using isopropyl alcohol with a lint-free cloth, make sure that the 

alcohol is at least 90% pure, obtainable from your local pharmacy. (Do not 
use rubbing alcohol; it can damage the printer.)

To clean the paper-pick rollers:

1 Slide the media tray out (you do not have to remove it) to 
allow access to the paper-pick rollers.

2 Open the left side door:
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3 Use the green handles to pull out the paper feeder.

4 Gently rotate the paper-pick rollers 180° (the paper-pick 
rollers are D-shaped) and wipe them with a lint-free 
cloth moistened with isopropyl alcohol.

5 Reinsert the paper feeder (a) and close the left side door 
(b).

a
b
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6 Slide the media tray back into place.

NOTE:
• If you have a 2nd Cassette Feeder, you may also need to clean 

the rollers for the middle and lower media trays, which are 
accessed through the lower left side door.

To clean the home sensor:

If your printer panel displays PRINTER ERROR 30, clean the home sensor 
inside the printer.

1 Open the printer’s front door.

2 Remove the imaging unit. 
Loosen the two thumbscrews by turning them 
counterclockwise (a). 
Turn the lower green lever 180° counterclockwise (b). 

a

b

a
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3 Grasping the front green handle, slide the imaging unit 
out until it catches (a). 
Lift up the left green handle. Pull the imaging unit out of 
the printer and cover it to protect it from light exposure 
(b). 

IMPORTANT:
• Do not touch the green surface (the right side) or the black belt 

(the underside). Finger prints may affect the print quality.

SAFETY CAUTION:
• The imaging unit weighs approximately 6.5 kg {14.3 lbs.}. Always 

use the handles when lifting it.

CAUTIONS:
• Do not expose the imaging unit to artificial light for more than 

45 seconds; or you may damage the unit. Never expose it to 
direct sunlight.

• Do not leave the printer’s front door open for an extended period 
of time (for example, several hours).

4 Use a dry, lint-free cloth to wipe the slot of the sensor.

a
b

Green surface

Black belt

Sensor

Slot
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5 Reinsert the imaging unit into the printer, holding it by its 
green handles.

Match the arrow on the right side of the imaging unit with the arrow 
on the printer, and slightly push the imaging unit into the printer. 
Then release the left handle and push the unit in until it stops.

6 Turn the lower green lever clockwise 180° to insert the 
unit completely and to lock it (a). 
Tighten the two green thumbscrews by turning them 
clockwise (b). 
Close the front door (c). 

a

c

b

b
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User replaceable components
When the printer panel indicates that a supply needs to be replaced, make 
sure that you have replacement supplies on hand. The printer may continue 
to print until the supply is completely used up; but then it stops until you 
replace the indicated supply.

*1These figures are based on an average of 5% coverage of the printable 
area and standard density for any one color (refer to Example A below 
left: Monochrome 5% coverage). 4 colors (Cyan, Magenta, Yellow and 
Black) are used for full color print. The frequency of replacement will vary, 
depending on the complexity of the prints and the percentage of coverage 
of each color and print density.
Example B below right is the case of full color print. The percentage of 
coverage of each color is as follows. Cyan: 40%, Magenta: 22%, Yellow: 
35%, Black: 20% If you continuously print with this setting, the average life 
of the Color Imaging Unit will be shortened to about 2,500 pages.

Printer component Printer panel message Average life

Color imaging unit*1

Change the imaging unit 
soon.

Monochrome 
57,000 pages 

or 
Color 14,250 
pages

Change the imaging unit 
now.

Monochrome 
60,000 pages 

or 
Color 15,000 
pages

Image Unit wearing out

Imaging Unit 
Worn out

Example BExample A
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*1Refer to *1 on page 140.
*2The starter cartridges that ship with the printer have an average life of 

approximately 3,000 pages, based on an average of 5% coverage.
*3Specialty media (Transparencies, coated paper, etc.) will result in 

shortening the life of a consumable to maintain better print quality. When 
replacing the fuser unit, replace the oil supply roll as well. Do not insert 
the used oil supply roll into the new fuser unit; it may damage the 
new fuser unit.

Printer component Printer panel message Average life

Toner cartridges*1*2

Change the color toner 
cartridge soon.

12,000 pages 
(Black)

or

10,000 pages 
(CMY)

Change the color toner 
cartridge now.

Fuser unit*3 (oil supply 
roll installed)

alternates with 

Change the Fuser unit soon.

28,500 pages

Change the Fuser unit now.

31,000 pages

Oil supply roll*3

Change the Oil supply roll 
now.

15,000 pages

Change the Oil supply roll 
now.

15,500 pages

Low <Color> Toner

<Color> Toner 
Empty

Fuser Unit wearing out

Oil Roll wearing out

Fuser Unit and Oil Roll 
Worn out

Oil Roll wearing out

Oil Roll 
Worn out
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NOTE:
• If you print with high density when Low <Color> Toner is displayed, you 

may get faded printout before <Color> Toner Empty is displayed.

*4When you have just replaced Transfer unit, you must select Yes in the New 
Transfer Unit menu. See “Maintenance” on page 143.

Printer component Printer panel message Average life

Transfer unit*4

Change the Transfer unit 
soon.

80,000 pages

Transfer wearing out
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Displaying the life of supplies and coverage of toner
This menu shows how much percentage of each consumable life remains to 
be used. Please note that the values shown here is just the approximate 
value and are not always correct. So the consumable wearing warning 
message might occur regardless of the displayed values.

Page Count—It shows the pages your KX-P8420 has printed since your 
purchase of the printer.

Toner Cartridge—It shows the percentage of CYAN, MAGENTA, YELLOW 
and BLACK toner cartridges remaining.

• CYAN : ###%Remaining
• MAGENTA : ###%Remaining
• YELLOW : ###%Remaining
• BLACK : ###%Remaining

Imaging Unit—###% remaining shows the percentage of the life of 
Imaging unit remaining.

Transfer Unit—It shows the percentage of the Transfer unit remaining.

• ###% remaining
It shows the percentage of the Transfer unit remaining.

• New Transfer Unit (No/Yes)
You must select Yes when you have just replaced Transfer unit. 
The life will be reset to 100% remaining by selecting Yes.

Fuser Unit—###% remaining shows the percentage of the Fuser unit 
remaining.

Oil Roll—###% remaining shows the percentage of the Oil roll remaining.

Last—It shows the percentage of the whole printable area covered by each 
toner in the previously printed page. This menu cannot show the value 
correctly just after the printer was turned on.

• CYAN: ###%
• MAGENTA: ###%
• YELLOW: ###%
• BLACK: ###%

Average—It shows the average percentage of the printable area of all 
pages printed covered by each toner.

• CYAN: ###%
• MAGENTA: ###%
• YELLOW: ###%
• BLACK: ###%

Maintenance

Image Area
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Clearing media jams
If the printer has frequent media jams, make sure that you follow these 
guidelines:

• Always use high-quality laser paper and transparencies. See page 197 
and 199.

• Make sure that you load specialty media only in the multi-purpose tray 
and that you set the media thickness switch to the correct setting for the 
media used.

If a media jam occurs, the printer panel reports JAM AT <LOCATION>, where 
<LOCATIONS> are the various sensors throughout the paper path, shown as 
A through E in the illustration below.

2nd cassette feeder (option)

Jam in location D 
(See page 153.)

Jam in location E 
(See page 155.)

Jam in the MPT 
(See page 156.)

Jam in location A 
(See page 145.)

Jam in location B 
(See page 148.)

Jam in location C (See page 149.)
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To clear media jams in location A:

1 Open the left side door corresponding to the selected 
media tray and remove the jammed media.

2 Close the left side door.

OR

1 Remove the media tray.

2 Remove the jammed media from inside the printer.

3 Reinsert the media tray.

4 Open and close the front door to clear the error 
message from the LCD.
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To clear media jams in the 2nd cassette feeder:

1 Open the lower left side door.

2 Remove the jammed media.

3 Close the lower left side door.

OR

1 Remove the selected media tray (middle or lower media 
tray).
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2 Remove the jammed media from inside the printer.

3 Reinsert the media tray.

4 Open and close the front door to clear the error 
message from the LCD.
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To clear media jams in location B:

1 Open the left side door.

2 Use the green handles to pull out the paper feeder.

3 Remove the jammed media on the paper feeder.

4 Reinsert the paper feeder and close the left side door.
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To clear media jams in location C:

1 Remove the fuser.

Open the printer front door (a). 
Turn the small green thumbscrew counterclockwise to 
unlock the fuser (b).

.

SAFETY CAUTION:
• The fuser is hot; to avoid personal injury, turn off the printer and 

wait 10 minutes (after opening the front door) for the fuser to cool 
before touching it.

2 Holding the green tab on the right, slide the fuser out 
until the safety catch stops it (a).

Press the green lever on the left to release the safety 
catch (b).

a

b

c

d

CAUTION:
HOT SURFACE INSIDE
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3 Hold the fuser as shown below, and slide it out of the 
printer (a).

Close the front door (b).

SAFETY CAUTION:
• The fuser unit weighs approximately 3.1 kg {6.8 lbs.}. Take care 

when handling it.

4 Remove the oil supply roll.

Press out on tabs to unlock the oil supply roll (a). 
Remove the oil supply roll out of the fuser (b).

NOTE:
• If the paper is not jammed in the fuser unit, perform the following. 

1. @ Repeat steps 1 to 4 of the procedure on page  148.  
2. @ Skip the next step and go to step 6.

b a

b

a

a
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5

 

Turn the fuser’s large green knob clockwise (

 

a

 

). 
Remove the jammed media (

 

b

 

).

 

6

 

Replace the oil supply roll into the fuser (

 

a

 

). 
Press down firmly on the oil supply roll to snap both 
sides into place (

 

b

 

).

NOTE:

 

•

 

If the oiled cloth is loose, rotate the gear (a) clockwise until it is 
tight. Do not touch the oiled cloth.

CAUTION:CAUTION:

 

•

 

If the oil supply roll is not installed correctly, print quality will be 
diminished.

a
b

a b

b
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7

 

Open the front door (

 

a

 

). 
Slide the fuser back into the printer (

 

b

 

).

 

8

 

Turn the small green thumbscrew clockwise to lock the 
fuser (

 

a

 

). 
Close the front door (

 

b

 

).

b

a

a

b
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To clear media jams in location D with face down printing:

SAFETY CAUTION:

 

•

 

The fuser is hot; to avoid personal injury, turn off the printer and wait 
10 minutes (after opening the front door) for the fuser to cool before 
touching it.

NOTE:

 

•

 

First check the exit opening for media that has jammed and folded like an 
accordion. It is especially difficult to see if the media is transparency film.

 

1

 

Open the front door (

 

a

 

). 
Pull open the access door (above the plastic output 
tray); see if the media is visible (

 

b

 

).

 

2

 

Turn the large green knob on the fuser counterclockwise 
(

 

a

 

). 
Remove the media from inside the access door (

 

b

 

).

b

a

b

a
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CAUTION:CAUTION:

 

•

 

If the fuser knob will not turn, do not force it, or you may damage 
the fuser. Instead, follow these steps:

a) Unlock the fuser by turning the small green thumbscrew 
counterclockwise.

b) Pull the fuser out. The media will probably tear.

c) Remove the oil supply roll.

d) Turn the fuser’s large green knob to release the jammed 
media.

e) Remove the jammed media from the fuser and the printer.

SAFETY CAUTION:

 

•

 

The fuser is hot; to avoid personal injury, turn off the printer and 
wait 10 minutes for the fuser to cool before touching it.

 

3

 

Close the front door.

 

To clear media jams in location D with face up printing:

 

1

 

Open the front door and the right side door (

 

a

 

).

Turn the fuser’s large green knob counterclockwise to 
release the jammed media (

 

b

 

).

Remove the jammed media from the right side of the 
printer (

 

c

 

).

 2
 

Close the front door and the right side door.

b

a

c



 

155

Care and Maintenance

 

To clear media jams in location E:

 

1

 

Remove the jammed media from the output tray.

 

OR

 

Pull open the access door (above the plastic output tray) 
and remove the media.

 

2

 

Open and close the front door to clear the error 
message from the front panel.
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To clear jams with the multi-purpose tray:

 

1

 

Remove the jammed media from the multi-purpose tray.

 

2

 

Open and close the front door to clear the error 
message from the front panel.
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Troubleshooting

 

Trouble Possible Cause Corrective Action

 

Ready indicator is 
blinking.

The printer is 
receiving, processing 
or printing job.

Wait for the job to be 
completed or cancel 
the job.

You have entered the 
Menu mode in the 
printer panel.

Exit the Menu mode 
by pressing the Menu/
Exit button.

The printer is 
networked and 
WebTools are being 
accessed.

Wait for the job to be 
completed.

Ready indicator is off. The printer is not 
ready, is disabled, or 
has detected an error.

Read the printer 
panel message to 
determine the printer 
status.

Error indicator is on. Error occurred that is 
not user-correctable.

Turn the printer off 
and back on again. If 
the indicator is still on, 
the printer requires 
service.

Error indicator is 
blinking.

The printer has 
stopped because it 
detected a user-
correctable error such 
as an open door or a 
media jam.

Correct the condition 
displayed on the 
printer panel (e.g., 
close the door or clear 
the media jam).

A single color is not 
uniform or many vertical 
streaks (both light and 
dark) of slightly different 
density and non-uniform 
color.

.

The toner is almost 
depleted.

Replace the color 
toner cartridge.
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Half tone area has 
areas of weak color.

Paper doesn’t match 
the environmental 
conditions, or it has 
too much moisture.

Try fresh paper, or 
another type of paper.

Store media in the 
original, dust-free 
package in the same 
environmental 
conditions as the 
printer.

A single color appears 
faded.

The color density is 
set incorrectly in the 
printer panel.

See “Chapter 7 Color 
Calibration”.

The toner is almost 
depleted.

Replace the color 
toner cartridge soon 
(depending on the 
complexity of your 
prints, you can 
continue to print up to 
100 more pages).

A single color has a 
sharp, dark or light 
vertical streak.

The toner cartridge is 
almost depleted and 
is not properly 
applying toner.

Replace the color 
toner cartridge.

Small white spots 
appear on OHP 
transparency.

OHP transparency 
has dust on its 
surface.

Remove dust or stain 
from OHP 
transparency.

 

Trouble Possible Cause Corrective Action
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A single color shows a 
light, repeating 
horizontal line.

The roller in the toner 
cartridge has a slight 
impression after a 
long period of 
storage.

Run 20-30 prints. The 
impression will 
disappear with 
continued time and 
use.

Prints are missing fine-
line detail.

The imaging unit has 
reached its useful life.

Replace the imaging 
unit.

Dark color spots and 
dark or light streaks 
appear in all colors. 

The imaging unit has 
reached its useful life.

Replace the imaging 
unit.

Straight, thin light 
vertical line in colors.

The photosensitive 
belt inside the 
imaging unit is 
scratched.

Replace the imaging 
unit.

Each color “bleeds” into 
the color band. 

The imaging unit’s 
internal waste toner 
box is full.

Replace the imaging 
unit.

 

Trouble Possible Cause Corrective Action



 

160

Care and Maintenance

 

A single white spot 
appears in 
approximately the same 
vertical place on the 
page.

The imaging unit is 
damaged.

Replace the imaging 
unit.

Large light spot(s) 
appear randomly.

Fingerprint(s) on the 
underside belt or 
photosensitive belt 
(inside) of the imaging 
unit.

Print several pages 
until the spots fade.

One or more dark 
vertical lines appear on 
the print in all colors.

The imaging unit is 
scratched.

Replace the imaging 
unit; make sure that 
the old imaging unit is 
not exposed to light 
for more than 45 
seconds. If a new 
imaging unit does not 
correct the problem:

• Put the old imaging 
unit back into the 
printer.

• Repack the new 
imaging unit.

The fuser is 
damaged. 

Replace the fuser.

 

Trouble Possible Cause Corrective Action
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A piece of the printed 
image is missing and 
reappears out of place, 
approximately 129 mm 
(5'') down the page.

The fuser’s internal 
roller is not being 
consistently oiled or 
The fuser’s internal 
roller is contaminated 
with toner particles.

Print 5-10 pages of 
blank pages to clean 
the roller. If you still 
see the problem:

• Replace the oil 
supply roll.
If you still see the 
problem:

• Replace the fuser.

The surface of the 
printed image appears 
to have vertical 
scratches (visible by 
holding the print at an 
angle and observing the 
“shine” of the image). At 
first, the scratches 
appear only on the 
printed image; 
eventually, dark vertical 
scratches appear on the 
imprinted portion of the 
page.

The fuser is near its 
useful life.

Replace the fuser 
(depending on your 
quality needs, you 
can continue to print 
until the dark vertical 
lines appear).

Media frequently wraps 
around the fuser.

The oil supply roll has 
reached its useful life.

Replace the oil supply 
roll.

Light vertical streaks 
appear in all colors.

The main charge grid 
is dirty.

Replace the imaging 
unit. 

 

Trouble Possible Cause Corrective Action
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Dark and wavy vertical 
streaks appear in all 
colors.

The main charge grid 
is dirty.

Replace the imaging 
unit. 

The entire page prints in 
black, including the 
borders.

Bad electrical contact 
for the main charge 
grid.

Reinsert the imaging 
unit to correct the 
contact for the main 
charge grid. 

The main charge grid 
is broken.

Replace the imaging 
unit.

Toner spots appear on 
the back of the media.

The transfer unit is 
worn out.

Replace the transfer 
unit. 

The page prints in black 
in the image area only. 
(The borders are clear.)

Either the image 
processor board or 
engine control board 
is not functioning 
properly.

Turn the printer off 
and back on again. If 
the problem persists, 
call for service on 
your printer.

 

Trouble Possible Cause Corrective Action
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If you can’t make a print:

The page is completely 
blank.

The problem could be 
with one of the 
following:

• Engine control 
board.

• Developer voltage.

• Laser scanning unit 
mirror.

Turn the printer off 
and back on again. If 
the problem persists, 
call for service on 
your printer.

Service Error is 
displayed on the LCD.

An error occurred that 
is not user-
correctable.

Turn the printer off 
and back on again. If 
the error persists, call 
for service.

Trouble Corrective Action

Printer not operating. Make sure that you plugged in the printer and 
turned it on.

Make sure that you connected the interface 
cable(s) properly.

More info to come for 
these messages.

If the communication link between your computer 
and the printer is working but the printer ejects a 
blank page when printing from your application or 
through Windows. Make sure that the 
appropriate driver is installed and that you have 
selected the printer correctly.

Trouble Possible Cause Corrective Action
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Media problem

Trouble Corrective Action

Frequent paper-
picking errors.

Fan the paper or transparencies before installing 
them in their respective trays; this is especially 
important for transparencies because they tend to 
stick together.

Make sure that you have loaded paper in the paper 
tray and transparencies in the transparency tray.

Make sure that the media is installed under the 
hooks at the front of the media tray.

If printing on transparencies and your printer has a 
2nd Cassette Feeder, make sure that the 
transparency tray is installed in the upper or middle 
tray slot.

Clean the paper-pick rollers. (See page 135 for 
directions.)

Frequent media 
jams.

Make sure that you use a high-quality laser paper: 

60–105 g/m2 (16-28 lbs.) paper in the media trays 

and 75–165 g/m2 (20–44 lbs.) paper in the multi-
purpose tray.

If you are using media that is 105 g/m2 (28 lbs.), 
check if the Face Down media output setting is 
selected in the driver. If it is, change the setting to 
Face Up.

Use only recommended transparencies. (See 
page 199.) We cannot guarantee the results of other 
transparencies.

Make sure that the media is installed under the 
hooks at the front of the media tray.

Do not overfill the media tray, as indicated by the red 
line on the right side of the tray.

Clean the paper-pick rollers. (See page 135 for 
directions.)

Make sure that the media thickness switch is set 
correctly for the installed media. (See page 36.)
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Problems with image size and position

Print quality problems

Trouble Corrective Action

Off-set images. Check your application for correct image sizing. 

Cut-off images. Check your application for image sizing. 

Make sure that the correct size media is in the 
media tray.

Trouble Corrective Action

Prints have dull, 
faded colors.

Adjust or calibrate colors. See “Chapter 7 Color 
Calibration”.

Make sure that the imaging unit stays covered until 
immediately before installing it in the printer. 
Exposure to light for more than 45 seconds can 
damage the imaging unit.

Make sure that the toner cartridges are installed 
correctly.

Make sure that you use a high-quality laser paper: 

60–105 g/m2 (16-28 lbs.) paper in the media trays 

and 75–165 g/m2 (20–44 lbs.) paper in the multi-
purpose tray.

Image is very 
faded or pieces of 
the image are 
missing; toner on 
the page is loose.

When using the multi-purpose tray, make sure that 
you have selected the correct media type in the 
driver or in the Menu mode of the printer panel.
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Streaks or spots Most spots are caused by fingerprints or dust 
introduced into the printer while installing the 
imaging unit or loading media. 

Make sure that the surface where you unpack the 
imaging unit, paper, and transparencies is free of 
dust. Keep supplies in a covered area or a closed 
box.

Make sure that the imaging unit stays covered until 
immediately before installing it in the printer. 
Exposure to light can damage the imaging unit and 
will produce light streaks or faded prints.

Do not touch the right side or underside of the 
imaging unit; fingerprints affect print quality.

Make sure that the paper or transparency film is 
clean.

Make sure that you handle the media on the outside 
edges to avoid fingerprints.

To get rid of fingerprint spots, print a few prints.

The back of the 
printed page 
appears dirty.

Toner particles have contaminated the transfer 
roller. This can happen if the printed image is larger 
than the media (for example, when printing on 
envelopes). Run 10-20 prints to clean the transfer 
roller.

The print quality of 
a transparency is 
poor.

There is a defect on the coated surface of the 
transparency. Print on the other side.

Trouble Corrective Action
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Front Panel Messages
When an error interferes with printing, you will see a message on the front 
panel. The following table lists the messages in alphabetical order, with the 
appropriate corrective action for each one.

NOTE:
• If the message indicates that you don’t have enough memory to finish 

printing, you may need to install additional memory to handle your 
workload. See “Installing additional memory” on page 189.

The following status messages cause the Ready indicator to blink. Printing 
will continue when corrective action (if required) is taken, and the Ready 
indicator is lit.

Message Corrective action/additional information

%s%s.%s Error 
DIMM Slot %s

Cycle Power. If printer does not function 
normally, call for service.

Black Toner Cartridge 
Not installed

Install black toner cartridge.

Black Toner
Empty

Replace black toner.

Canceling Job When the Cancel button is pressed, the job 
currently being processed is deleted.

Charger 
Not installed

Install the charger unit.

Controller Memory Error
Cycle Power

Cycle Power. If printer does not function 
normally, call for service.

Cyan Toner Cartridge 
Not installed

Install cyan toner cartridge.

Cyan Toner
Empty

Replace cyan toner.

DC Controller 
Malfunction

Cycle Power. If the printer does not function 
normally, call for service.

Disk File
Operation Failed

Hard disk is functioning abnormally. Cycle 
Power. If printer does not function normally, 
call for service.

Front panel 
status and error 
messages
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Disk Is Full Erase or replace the printer’s hard disk. 
Execute the Reset Queues menu from the 
printer’s front panel. See “Reset Queues” on 
page 107.

Disk
Device Failure

Cycle Power. If printer does not function 
normally, call for service.

Error %s
Cycle Power

Unrecoverable error happened. Turn off the 
printer.

Engine Interface Error
Cycle Power

Cycle Power. If printer does not function 
normally, call for service.

Flash 
Device Failure

Flash DIMM hardware error. Cycle Power. If 
printer does not function normally, call for 
service.

Flash File
Operation Failed

Hard disk is functioning abnormally. Cycle 
Power. If printer does not function normally, 
call for service.

Front or Right door
Open

Close Front or Right door.

Fuser Unit 
wearing out

Fuser unit will need to be replaced soon.

Fuser Unit
Not installed

Install a Panasonic fuser unit.

Fuser Unit
Worn out

Replace the fuser unit.

Imaging Unit 
wearing out

Imaging unit will need to be replaced soon.

Imaging Unit
No tension

Set the upper lever of the imaging unit to 
“Lock”.

Imaging Unit
Not installed

Install imaging unit.

Imaging Unit
Worn out

Replace the imaging unit.

Initializing Printer is initializing.

Insert printed pages in
MP tray, press Continue

Insert printed pages into multi-purpose (MP) 
tray, then press the Continue button.

Message Corrective action/additional information
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Insufficient
Memory

Not enough memory to finish printing. 
Change printing resolution to 600 x 600 dpi if 
you selected higher resolution. 
or 
Install additional memory in the printer.

Jam at A
See front door label

Clear paper jam. See front door label. 
(See page 145.)

Jam at B
See front door label

Clear paper jam. See front door label. 
(See page 148.)

Jam at C
See front door label

Clear paper jam. See front door label. 
(See page 149.)

Jam at D
See front door label

Clear paper jam. See front door label. 
(See page 153.)

Jam at E
See front door label

Clear paper jam. See front door label. 
(See page 155.)

Jam at MPT Clear paper jam. See front door label. 
(See page 156.)

Left side door
Open

Close Standard Cassette side door.

Load A4 Load A4 size paper.

Load A4
in Lower tray

Load A4 size paper in Lower tray.

Load A4
in Middle tray

Load A4 size paper in Middle tray.

Load A4
in Upper tray

Load A4 size paper in Upper tray.

Load Legal Load legal size paper.

Load Legal
in Lower tray

Load legal size paper in Lower tray.

Load Legal
in Middle tray

Load legal size paper in Middle tray.

Load Legal
in Upper tray

Load legal size paper in Upper tray.

Load Letter Load letter size paper.

Load Letter
in Lower tray

Load letter size paper in Lower tray.

Message Corrective action/additional information
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Load Letter
in Middle tray

Load letter size paper in Middle tray.

Load Letter
in Upper tray

Load letter size paper in Upper tray.

Low Black Toner Black toner will need to be replaced soon.

Low Cyan Toner Cyan toner will need to be replaced soon.

Low Magenta Toner Magenta toner will need to be replaced soon.

Low Yellow Toner Yellow toner will need to be replaced soon.

Lower Left side door
Open

Close Optional Cassette side door.

Lower Tray
Empty

Add media to Lower tray.

Lower Tray
Not installed

Install Lower tray.

Magenta Toner Cartridge 
Not installed

Install magenta toner cartridge.

Magenta Toner
Empty

Replace magenta toner.

Media Tray
Empty

Add media to Media tray.

Media Tray
Not installed

Install Media tray.

Memory Error 0 Cycle Power.

Memory Error 1 Cycle Power.

Memory Error 2 Cycle Power.

Memory Error 3 Cycle Power.

Memory Error 4 Cycle Power.

Memory Error 5 Cycle Power.

Memory Error 6 Cycle Power.

Memory Error 7 Cycle Power.

Memory Error 8 Cycle Power.

Message Corrective action/additional information
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Memory Shortage
Page Simplified

Not enough memory to finish printing. 
Change printing resolution to 600 x 600 dpi if 
you selected higher resolution. 
or 
Install additional memory in the printer.

Middle Tray
Empty

Add media to Middle tray.

Middle Tray
Not installed

Install Middle tray.

Multi-Purpose Tray
Empty

Add media to multi-purpose tray.

NVRAM Error
Settings Changed

NVRAM hardware error. Cycle Power. If 
printer does not function normally, call for 
service.

NVRAM Full
Settings Lost

Hardware error of Flash DIMM. Cycle Power. 
If printer does not function normally, call for 
service.

Oil Roll
Not installed

Install oil web unit.

Oil Roll
wearing out

Oil supply roll will need to be replaced soon.

Oil Roll
Worn out

Replace the oil web unit.

Out of Memory
Job Cleared

Not enough memory to finish printing. 
Change printing resolution to 600 x 600 dpi if 
you selected higher resolution. 
or 
Install additional memory in the printer.

Out of Memory
Job Failed

Not enough memory to finish printing. 
Change printing resolution to 600 x 600 dpi if 
you selected higher resolution. 
or 
Install additional memory in the printer.

Output Tray
Full

Remove media from Output tray.

Page
Too complex

Not enough memory to finish printing. 
Change printing resolution to 600 x 600 dpi if 
you selected higher resolution. 
or 
Install additional memory in the printer.

Message Corrective action/additional information
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Paper Feeder
Not installed

Install paper feeder.

Parallel I/O 
Buffer Overflow

Not enough memory to finish printing. 

PJL Operations 
Failed

Error in PJL code. Resend print job to the 
printer.

Press Enter to
Initialize Disk

Press the Enter button to initialize a new hard 
disk. This message will also appear if the hard 
disk has malfunctioned, or if the hard disk is 
the incorrect type. If this error appears after 
cycling power to the printer, contact an 
authorized service representative.

Printing 
Configuration

Printer is printing the Configuration page.

Printing 
Font List

Printer is printing the Font List page.

Printing 
Test Page

Printer is printing the Test Page.

Processing Printer is receiving or processing a print job.

PS Memory Full Not enough memory to finish printing. 
Change printing resolution to 600 x 600 dpi if 
you selected higher resolution. 
or 
Install additional memory in the printer.

PS Memory Full
Stored Data Lost

Not enough memory to finish printing. 
Change printing resolution to 600 x 600 dpi if 
you selected higher resolution. 
or 
Install additional memory in the printer.

RAM Test Failure
Cycle Power

Cycle Power. If printer does not function 
normally, call for service.

Scan Buffer Error
Cycle Power

Cycle Power. If printer does not function 
normally, call for service.

Service (%s) 
Cycle Power

Firmware error. Contact an authorized service 
representative.

Transfer
wearing out

Transfer unit will need to be replaced soon.

Message Corrective action/additional information
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Some operation errors cause the error indicator to blink and printing to stop. 
A message will be displayed on the front panel until the problem is fixed. If 
the front panel message includes the instruction, Call for Service, contact 
an authorized service representative.

In addition, if the following conditions occur, turn off and unplug the printer 
from the outlet and contact a qualified service representative:

• The power cord or plug is damaged or frayed.

• Liquid has been spilled into the printer.

• The printer has been exposed to rain or water.

• The printer does not operate normally though the operating instructions 
are being followed. Adjust only those controls that are described in the 
operating instructions; improper adjustment of other controls may result in 
damage and will often require extensive work to restore the printer to 
normal operation.

Transparency Tray
Not installed

Install transparency tray.

Upper Left side door
Open

Close Left side door.

Upper Tray
Empty

Add media to Upper tray.

Upper Tray
Not installed

Install Upper tray.

Warming Up Printer is warming up.

Yellow Toner Cartridge 
Not installed

Install yellow toner cartridge.

Yellow Toner
Empty

Replace yellow toner.

Message Corrective action/additional information

Front panel 
service calls
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Repacking
It is highly recommended that you keep the original carton and ALL packing 
materials. Should you need to transport or ship your printer, please follow 
these instructions.

SAFETY CAUTION:
• The printer weighs about 47.9 kg {105.5 lbs.}. It must be handled by two 

people.

NOTES:
• Should you need to send your printer for service, consult your reseller first 

or Panasonic.

• Please use the original carton and all of the original packing materials.

• If you do not have the packing for the imaging unit and the transfer unit: 
contact Panasonic for packaging.

• Improper repacking of the printer may result in a service charge to 
remove spilled toner.

• Since the printer uses dry toner, extreme care must be taken when 
handling. The printer should be handled in the upright (vertical) position.

Material required:

• Original cartons and packing materials

• Newspaper or drop cloth

• Shipping tape and scissors
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To prepare the printer for repacking:

1 Turn off the printer; remove the power cord and all 
interface cables.

2 Remove the media tray(s) from the printer; remove the 
media from the tray(s).

3 Press down on a media tray’s metal plate. Place the 
cardboard packing material into the media tray.

4 Reinsert the media tray into the printer; use adhesive 
tape to secure the tray to the printer.

5 If you have other media trays, repack them for shipping 
or storage in their original shipping boxes.
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6 Open the printer’s front door (a).
Loosen the two thumbscrews by turning them 
counterclockwise (b).
Turn the lower green lever 180° counterclockwise (c).

.

7 Grasping the front green handle, slide the unit out until it 
catches (a).
Lift up the green handle on the left and pull the imaging 
unit out of the printer (b).

IMPORTANT:
• Do not touch the green surface (the right side) or the black belt 

(the under side). Finger prints may affect the print quality.

SAFETY CAUTION:
• The imaging unit weighs approximately 6.5 kg {14.3 lbs.}. Always 

use the handles when lifting it.

b

a

b
c

a
b

Green surface

Black belt
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8 Wrap the imaging unit with a protective black plastic 
sheet.

CAUTION:CAUTION:
• Do not expose the imaging unit to light for more than 45 seconds 

to avoid damage.

9 On the imaging unit, turn the upper lever 90° 
counterclockwise; this is necessary to protect the 
imaging unit during shipment.
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10 Insert the imaging unit into the packaging.

11 Open the left side door and using the green handles (a).
Slide the paper feeder out (b).

a
b
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12 Push in on green tabs to unlock the cover (a).
Raise the cover until it catches in the open position (b).

13 Rotate the transfer unit’s green handles up (a). 
Lift out the transfer unit (b).

14 Place the transfer unit on newspaper or drop cloth. 
Rotate the handles down and wrap the transfer unit with 
a piece of paper and adhesive tape.

NOTE:
• Do not touch or bump the roller: it can damage the roller.

a

b

a

a
b
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15 Install the plastic cover and insert the transfer unit into a 
plastic bag and seal the end tightly. Install the transfer 
unit into the packaging.

To pack the toner cartridges:

1 Open the right side door (a).
Remove a toner cartridge (b).

CAUTION:CAUTION:
• To avoid possible toner spillage, do not tilt the cartridge.

2 Replace the shipping cover (a).
Secure the shipping cover with adhesive tape (b).

Plastic cover

Plastic bag

a

b

b
a
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3 Insert each toner cartridge into a plastic bag and seal 
the end of the bag tightly.

4 Repeat steps 1 (b) through 3 for each toner cartridge.

To finish repacking the printer:

1 Wipe off any loose toner in and around the printer.

NOTE:
• If a toner vacuum is available, it is the best tool for cleaning 

spilled toner. Do not use a standard office vacuum; the toner will 
not be retained by typical vacuum dust collectors.

2 Raise the output tray and secure it to the printer with 
adhesive tape.

3 Secure the front door, the multi-purpose tray and the left 
side door to the printer with adhesive tape.

If you don’t have a 2nd Cassette Feeder, go to step 6 on next page.



182

Care and Maintenance

4 If you have a 2nd Cassette Feeder, lift the printer up and 
away from the 2nd Cassette Feeder.

SAFETY CAUTION:
• The printer weighs approximately 41.4 kg {91.2 lbs.} and the 2nd 

Cassette Feeder weighs approximately 14.3 kg {31.5 lbs.}. 
Observe standard precautions for lifting heavy objects.

5 Repack the 2nd Cassette Feeder in its original shipping 
box.

6 Repack any other accessories in their original shipping 
boxes.

7 Repack the printer in the original shipping box. Make 
sure that you keep the printer upright and level when 
moving.
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Upgrade options
The following upgrade options and consumables are available for the 
KX-P8420 Color Printer from you local Panasonic reseller:

• Hard Disk Drive (KX-PDHD1) for storing print jobs, and additional fonts 
(page 186)

• 16MB (KX-PEMD1) or 32MB (KX-PEMD2) RAM DIMMs (page 189)

Three DIMM slots for additional memory are available on the printer 
controller board. Each slot can support a 16MB or 32MB RAM DIMM.

• Ethernet (KX-PNBC5) or Token Ring (KX-PNBC6) network card 
(page 192)

You must remove the printer controller board from the back of the 
KX-P8420 in order to install or replace the hard disk, add or replace 
memory, or install a Token Ring or Ethernet network card.

Removing and replacing the printer controller board
To remove the printer controller board:

1 Turn the printer OFF, unplug the power cord and 
disconnect any cables connected to the connectors on 
the back of the printer.

2 Loosen the two screws that secure the printer controller 
board to the back of the printer.
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3 Carefully pull the printer controller board out of its slot in 
the printer.

For instructions on installing printer options see:

• “Installing a hard disk drive” on page 186

• “Installing additional memory” on page 189

• “Installing network cards” on page 192

Printer controller board
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To replace the printer controller board:

1 Align the printer controller board with the groove on the 
back of the printer and carefully slide it back inside the 
printer.

2 Tighten the two panel screws on the printer controller 
board that you loosened earlier.

3 Plug in the power cord and reconnect any cables to the 
back of the printer.

Printer controller board
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Installing a hard disk drive
The following section explains how to install the hard disk drive on the 
KX-P8420. It also describes how to initialize the new hard disk drive for use 
from the printer’s front panel.

To install the hard disk drive you will need to remove the printer controller 
board, install the drive and then replace the printer controller board in the 
printer. For instructions, see “Removing and replacing the printer controller 
board” on page 183.

SAFETY CAUTIONS:
• To avoid electric shock ensure your hands are dry before touching the 

printer’s power plug.

• Do not drop or bend the hard disk drive.

• Do not touch the hard disk drive connector.

• Protect the hard disk drive from static electricity by keeping it in its anti-
static package until you are ready to install it.

• Avoid exposing the hard disk drive to direct sunlight, high temperatures, 
or humidity.

Kit contents

• Four screws • Four stand offs

• Hard disk drive (KX-PDHD1) • Cable
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To install a new hard disk drive:

1 Place the printer controller board on a stable surface. 

2 Insert the provided cable into the connector on the 
printer controller board, directing a projection on the 
cable against the groove in the connector.

Slide the cable until the click is heard.

3 Unpack the new hard disk drive. With the electrical 
circuit board side up, place the drive on a flat surface or 
on the palm of your hand.

Do not touch the drive with magnetic objects or place objects 
sensitive to magnets near the drive.

4 Screw the four stand offs in the back of the hard disk 
drive.

Cable

Projection

Hard disk drive



188

Options

5 Put the four stand offs of the hard disk drive into the four 
holes, and secure the hard disk drive on the printer 
controller board with four screws.

6 Insert the other end of the cable into the connector on 
the hard disk drive.

The pins on the hard disk drive’s connector are in two groups 
(A and B). Be sure to insert the cable into the part A.

7 Replace the printer controller board in the printer. 

For instructions, see “Removing and replacing the printer controller 
board” on page 183.

A
B
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After you install the hard disk and power on the printer, you maybe 
prompted to initialize the new hard disk drive. If so, follow the directions 
below:

1 From Ready or Ready(Sleep), press the Menu/Exit 
button to enter the Setup menus.

2 Press the Continue/Forward button until Hard Disk 
appears. Follow the instructions on the LCD.

Installing additional memory
The following section explains how to install a 16 or 32MB RAM (random 
access memory) DIMM (dual in-line memory module) on the KX-P8420.

To install the RAM DIMM (illustrated below) you will need to do the 
following:

• Remove the printer controller board from the back of the printer.

• Replace the printer’s 16MB RAM DIMM with a 32MB RAM DIMM, or 
install a 16 or 32MB RAM DIMM in either of the two empty RAM slots on 
the printer controller board.

• Replace the printer controller board.

IMPORTANT:
• To avoid electric shock ensure your hands are dry before touching the 

printer’s power plug.

• RAM DIMM

CAUTIONS:
• Do not drop or bend the RAM DIMM.

• Do not touch the connector edge of the RAM DIMM.

• Protect the RAM DIMM from static electricity by keeping it in its anti-static 
package until you are ready to install it.

• Avoid exposing the RAM DIMM to direct sunlight, high temperatures, or 
humidity.

Initializing the hard 
disk

Kit contents
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The printer controller board ships with the following memory configuration:

• The DIMM slot numbered J1, is reserved for the printer’s system software 
ROM DIMM.

• The DIMM slot numbered J8 contains a 16MB RAM DIMM. 

• The remaining two slots, J2 and J3 are empty. 

Additional RAM DIMMs may be purchased for your printer in 16 or 32MB 
configurations, allowing your printer a maximum memory configuration of 
80MB of RAM. 

To install a RAM DIMM you will need to remove the printer controller board, 
install the RAM DIMM, then replace the controller board in the printer. For 
instructions, see “Removing and replacing the printer controller board” on 
page 183.

Installing RAM 
DIMMs

J8—RAM DIMM

J1—ROM DIMM

J2—Empty

J3—Empty
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To install a RAM DIMM:

1 Unpack the RAM DIMM(s). 

Do not touch the connector edge on the RAM DIMM.

2 Place the printer controller board on a stable surface. 

3 If you are replacing a RAM DIMM, unlatch the lever(s) 
on the side of the RAM DIMM you are replacing (a) and 
carefully slide it out of the socket (b). 

Some sockets have only one lever. 
If you will install additional RAM DIMM(s) in the empty slot(s) J2 or 
J3, skip this step.

4 Ensure that the notches on the RAM DIMM are aligned 
inside the empty socket.

5 Slide the RAM DIMM into the empty socket at a 45-
degree angle and push the DIMM into the socket (a) 
until the lever(s) snap into place (b).

6 Replace the printer controller board in the printer.

For instructions, see “Removing and replacing the printer controller 
board” on page 183.

b

a

RAM DIMM in slot J8

a

b
RAM DIMM

Socket
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Installing network cards
The following section explains how to install either an Ethernet (KX-PNBC5) 
or Token Ring (KX-PNBC6) network card (illustrated below) on the 
KX-P8420. It also describes how to configure the printer Setup when the 
new network card has been installed. 

To install the network card you will need to do the following:

• Remove the printer controller board from the back of the printer.

• Install the network card on the printer controller board.

• Replace the printer controller board.

• Configure the printer’s network setup.

IMPORTANT:
• To avoid electric shock ensure your hands are dry before touching the 

printer’s power plug.

• Ethernet (KX-PNBC5) or Token Ring (KX-PNBC6) network card

CAUTIONS:
• Do not drop or bend the network card.

• Do not touch the connector of the network card.

• Protect the network card from static electricity by keeping it its anti-static 
package until you are ready to install it.

• Avoid exposing the network card to direct sunlight, high temperatures, or 
humidity

Before you begin this procedure, remove the printer controller board from 
the printer. For instructions, see “Removing and replacing the printer 
controller board” on page 183.

Ethernet card Token Ring card

Kit contents
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Installing a network card:

1 Place the printer controller board on a stable surface.

2 Use a flat blade screwdriver to gently remove the 
connector cover on the side of the network card 
connector (a).

Remove the two screws that secure the slot cover on 
the front bracket, then remove the slot cover (b).

a

b

Connector cover on 
network card connector

Slot cover
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3 Align the network card into the cutout in the front bracket 
(a). 
And then into the network card connector (b). 
Secure the network card to the front bracket using the 
two screws you removed from the slot cover (c).

4 Replace the printer controller board in the printer. 

For instructions, see “Removing and replacing the printer controller 
board” on page 183.

5 Connect the printer to a network.

For instructions, see “Chapter 3 Connecting the Printer to a 
Network”.

c

a

b

Network card 
[The figure is Ethernet 
(KX-PNBC5) network card.]
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This appendix contains specifications for the following:

• Printer 

• Media

• Bidirectional Parallel Interface

• Controller 

Specifications

Printing method

Semiconductor Laser

Power source

Refer to the nameplate on the rear of the unit.

Temperature

Operating: 10°C to 32.5°C (50°F to 90.5°F) 
Best Print Quality: 15°C to 25°C (59°F to 77°F) 
Storage: 0°C to 40°C (32°F to 104°F)

Humidity

Operating: 20% to 80% RH. 
Best Print Quality: 30% to 70% RH. 
Storage: 10% to 80% RH

Warm up time

Less than 200 seconds (at 20°C)

Power consumption

850 W Max. (printing with fuser on), 
40 W (standby with fuser off), 
35 W (ENERGY STAR Mode) Meets ENERGY STAR power conservation 
requirements.

Mass {Weight} of standard unit with consumables
(without optional 2nd cassette feeder)

47.9kg/105.5 lbs.

Dimensions of standard unit (Without 2nd cassette feeder)

Height: 463 mm (18.2")
Depth: 493 mm (19.4") 
Width: 510 mm (20.1") [784 mm (30.9") with the output tray]

Noise level

53 dB(A) [Printing Mode] 
47 dB(A) [Standby mode]

Printer



196

Appendix

Paper output

Up to 500 sheets [75 g/m2 (20 lbs.)]

Resolution

600x600 dpi, 
1200x600 dpi 
(more than or equal to 32MB RAM required, with RAM DIMM option 
installed) 
or 
1200x1200 dpi 
(more than or equal to 32MB RAM required, total of 48MB RAM 
recommended, with RAM DIMM option installed)

Maximum printing speed

3.5 ppm (Full Color), 14 ppm (Monochrome) at 600x600 dpi

■ Media sizes

NOTE:
• Please store your paper according to the recommendations of the 

manufacturer.

Media Size Dimensions

Paper Letter 216 mm x 279 mm (8.5" x 11")

A4 210 mm x 297 mm (8.3" x 11.7")

Legal 216 mm x 356 mm (8.5" x 14")

Transparency Letter 216 mm x 279 mm (8.5" x 11")

A4 210 mm x 297 mm (8.3" x 11.7")

Envelope Env. #10 104.3 mm x 241.3 mm (4.13" x 9.5")

Media 
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■ Margins and print area
When the image is printed on the media, the image (print area) is a bit 
smaller than the media size. You may need to adjust the page margins in 
the application software to match the print area. 
The following table and illustrations show the page sizes, the largest print 
areas, and the margins for the media sizes supported on this printer.

■ Paper weight
The printer is designed to work well with most types of paper. However, 
differences in paper may have significant effects on the quality of the print 
or the reliability of paper handling. It is strongly recommended that you 
always test paper before purchasing it to make sure it provides desirable 
performance.

• Recommended paper (for optimum performance):

LETTER/LEGAL: Hammermill LASERPRINT 90 g/m2 (24 lbs.)

A4: NEUSIEDLER COLOR COPY 90 g/m2

NOTE:
• We do not recommend the use of 105 g/m2 (28 lbs.) paper in areas of high 

or low humidity and temperature since paper feed problems may be 
experienced.

Media Page Size Print area
Margins

Top Bottom Sides

Letter 216 mm x 279 mm 
(8.5" x 11")

208 mm x 269 mm 
(8.2" x 10.6")

4.3 mm 
(0.17")

4.3 mm 
(0.17")

3.7 mm 
(0.15")

A4 210 mm x 297 mm 
(8.3" x 11.7")

203 mm x 289 mm 
(8.0" x 11.4")

3.6 mm 
(0.14")

3.6 mm 
(0.14")

4.1 mm 
(0.16")

Legal 216 mm x 356 mm 
(8.5" x 14")

208 mm x 350 mm 
(8.2" x 13.8")

3.1 mm 
(0.12")

3.1 mm 
(0.12")

3.7 mm 
(0.15")

Media tray
One-sided 

printing

B&W 60 to 105 g/m2 (16 to 28 lbs.)

Color 75 to 105 g/m2 (20 to 28 lbs.)

Multi-purpose

tray

One-sided 

printing

B&W 75 to 165 g/m2 (20 to 44 lbs.)

Color 75 to 165 g/m2 (20 to 44 lbs.)

Two-sided 
printing

B&W 75 to 105 g/m2 (20 to 28 lbs.)

Color 90 to 105 g/m2 (24 to 28 lbs.)
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■ Types of paper to avoid
• Extremely smooth or shiny paper or paper that is highly textured

• Letterhead imprinted with low temperature or thermography. These 
materials may transfer onto the fusing roller and cause damage. 
Any pre-printed paper should use inks compatible with 200°C (392°F) for 
0.1 second.

• Damaged or wrinkled paper, or paper with irregularities such as tabs, 
staples, etc.

• Multipart forms or carbonless paper

• Paper with a 25% or more cotton and/or fiber content

• Ink jet paper (It may transfer onto the fuser roller and cause damage.)

■ Two-sided printing
Two-sided printing is possible by using the multi-purpose tray. However, 
you should not expect the same print quality and reliability that you get with 
one-sided printing. We strongly recommend that you follow the guidelines 
below.

• Do not load more than 10 sheets in the multi-purpose tray.

• Before loading paper in the multi-purpose tray, adjust it so that the edges 
of the media are lightly touching the media guides of the multi-purpose 
tray.
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■ Transparencies and labels
You may also print on transparencies and labels that are made for the 
printer. Panasonic has tested and found that the following work 
satisfactorily:

OHP transparency: 3M CG3700
Labels: AVERY 5163, AVERY 5164, AVERY 5165, Avery L7163, 
Avery L7165, Avery L7166, Avery L7167, Avery L7168, Avery L7169

• Re-using transparencies that have been fed through the printer once (for 
example, after jams or if the transparency is ejected without being 
printed) can reduce the life of the consumables and paper path 
components.

• When using transparencies, if the print quality is poor, print on the other 
side.

• With any label stock, the labels must completely cover the backing 
material. 

Labels cover the entire backing material.

YES

The backing material is exposed.

NO
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■ Envelopes
It is recommended that you print in black text only and purchase high quality 
#10 laser envelopes with diagonal seams, as shown in the diagram below:

High quality envelopes have the following characteristics:

• A thin, sharply creased leading edge

• Paper weight of 90 g/m 2 (24 lbs.)

• Flat, free of curls, wrinkles, nicks, etc.

NOTE:
• Wrinkle may occur in some case, even if high quality envelopes are used.

It is not recommended that you use envelopes with any of the following 
characteristics (using these may result in paper jams):

• Irregularly shaped envelopes

• Envelopes with curls, wrinkles, nicks, twists, dog-ears or other damage

• Envelopes with side seam construction
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• Highly textured envelopes, or with extremely shiny surfaces

• Envelopes that seal by removing a peel-off strip

• Envelopes with more than one flap to be sealed

• Self-adhesive envelopes

• Envelopes that are baggy or not sharply creased

• Embossed envelopes

• Envelopes that have previously been printed on

Do not attempt to print on any of the following types of envelopes. These 
may cause damage to your printer.

• Envelopes with clasps, snaps or tie strings (as illustrated on left below)

• Envelopes with transparent windows (as illustrated on right below)

• Envelopes that will melt, discolor, scorch offset or release hazardous 
emissions when exposed to 200°C (392°F) for 0.1 second

• Envelopes that use encapsulated types of adhesive that do not require 
moistening but rely on pressure to seal them

Always test a sample of the envelopes you are thinking of buying. Confirm 
that the envelope performs acceptably.
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■ For best printing results
• Avoid printing in high humidity i.e., above 70%.

 High humidity may cause the envelope to curl and pick up excess toner.

 High humidity may also cause the envelope to seal.

• Avoid printing below 10°C (50°F) with less than 30% relative humidity. 
Low temperature with low humidity may cause light printing.

• Print only one envelope at a time.

Envelope storage is very important. Store them away from moisture and 
humid air, where they can lay flat and their edges won’t be bent or 
damaged. The humidity should not exceed 70% RH.

The bidirectional parallel interface is based on the IEEE P1284-C standard.

If your computer has a bidirectional parallel port, the printer driver and 
printer can take advantage of faster data transfer.

■ Specifications

■ Pin configuration

Connector Type IEEE 1284-C type connector

Cable Use a shielded cable 2 m (6.6 ft) or less in length.

Signal pin Return side pin Signal

1 19 Busy

2 20 Select

3 21 nAck

4 22 nFault

5 23 PError

6 24 Data 1

7 25 Data 2

8 26 Data 3

9 27 Data 4

Bidirectional 
Parallel Interface
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■ Parallel Interface connector (printer side)

NOTES:
• “Return” denotes the return side wire of a twisted pair cable and is 

connected to signal ground.

• Be sure to use only a shielded cable. The printer will not operate properly 
if any of the pin is not connected.

10 28 Data 5

11 29 Data 6

12 30 Data 7

13 31 Data 8

14 32 nlnit

15 33 nStrobe

16 34 nSelectin

17 35 nAutoFd

18 — +5V(Host)

36 — +5V(Peripheral)

Signal pin Return side pin Signal

18 1

36 19
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CPU

133 MHz, 4700 CPU

Hard drive

Option 

ROM

16MB

Memory (RAM)

Standard: 16MB
Optional: additional 16MB or 32MB DIMM upgrades available.

(Expandable to a maximum 80MB of RAM)

Host interface

IEEE compliant, 1284 type C, Mini-Centronics parallel port interface

Ethernet card (option): AUI and RJ45 (10/100Base TX)

Token Ring card (option): RJ type and DB9 type

User interface

24 character, 2 line LCD panel, 2 indicators

NVRAM

1MB

Controller
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Bindery and NDS on the same network . . . . . . . 117
client setup,Windows 95  . . . . . . . . . . . . . . . . . . . 78
network port with Windows 3.1  . . . . . . . . . . . . . . 90

NetWare 4.x bindery context . . . . . . . . . . . . . . . . . . . 60
NetWare File Server  . . . . . . . . . . . . . . . . . . . . . . . . . 63
NetWare File Server, Bindery

setting up more than one . . . . . . . . . . . . . . . . . . 119
NetWare Print Console  . . . . . . . . . . . . . . . . . . . . . . . 63
NetWare Print Server . . . . . . . . . . . . . . . . . . . . . . . . . 64
NetWare queue  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
Network cards  . . . . . . . . . . . . . . . . . . . . . . . . . 192–194
Network protocols  . . . . . . . . . . . . . . . . . . . . . . . . 43, 49
Network settings, specifying on front panel . . . . . . . . 43
Network Setup menu . . . . . . . . . . . . . . . . . . . . 103–107
Network Setup option  . . . . . . . . . . . . . . . . . . . . . . . . 43



207

Index

Networks
setting network-specific information . . . . . . 103–107

Novell NetWare (shell version 3.26 and above) 
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Printer drivers
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troubleshooting  . . . . . . . . . . . . . . . . . . . . . 157–166
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